Support Package Manager
Content

1  Support Package Manager ................................................................. 4
   1.1 General Description of the Import Process .................................. 5
   1.2 Authorizations ........................................................................... 6
   1.3 Support Packages: Types ............................................................. 7
   1.4 Support Package Manager Settings ............................................. 8

2  Importing Support Packages with Support Package Manager ............ 13
   2.1 Importing a SPAM/SAINT Update ............................................... 14
   2.2 Importing CRM Support Packages ............................................. 15
   2.3 Loading Support Packages ......................................................... 16
       Loading Support Packages from the Application Server ................. 17
       Loading Support Packages from the Front End ............................. 18
   2.4 Defining the Support Package Queue .......................................... 19
       Rules for the Queue .................................................................. 20
       Defining a Queue Based on One Software Component .................. 20
       Defining a Queue Based on Multiple Software Components .......... 22
       Defining a Queue Based on a Target Support Package .................. 24
       Including Modification Adjustment Transports ............................ 25
   2.5 Importing a Queue ..................................................................... 27
       Defining the Start Options ......................................................... 30
   2.6 Import Mode: Downtime-Minimized ............................................ 32
   2.7 Adjusting Modifications .............................................................. 34
   2.8 Checking Logs ........................................................................... 37
   2.9 Confirming the Queue ............................................................... 38

3  Displaying Additional Status Information ........................................ 40

4  Importing Support Packages into Other Systems .............................. 43

5  Phases ............................................................................................ 44

6  Troubleshooting .............................................................................. 47
   6.1 Performing ABAP/Dynpro Generation ........................................ 47
   6.2 Checking the Status of Background Processing ............................ 49
   6.3 Test Import ............................................................................... 50
   6.4 Checks While Importing a Queue ............................................... 51
   6.5 Errors in Support Package Manager Phases ................................. 54
   6.6 Resetting the Status of a Support Package ................................. 62
1 Support Package Manager

Support Package Manager (transaction SPAM) provides you with an easy and effective way of importing SAP support packages into your system.

Use

You can obtain Support Packages from the SAP Support Portal under http://support.sap.com/patches or on collection CDs.

Support Package Manager runs at the SAP system level. Knowledge of the operating system is therefore not required for handling this tool.

Note

You can use Support Package Manager only with SAP GUI for Java and SAP GUI for Windows.

Note

The Support Package Manager update (SPAM/SAINT Update) is shipped in English and German only. If you are working in any other language, new or updated user interface elements or texts might be displayed in English or German only. We therefore recommend that you logon in either English or German when using Support Package Manager.

By pressing the Info button in Support Package Manager, you can obtain the latest version of the documentation, together with information about the new Support Package Manager functions.

Calling Support Package Manager

You can call Support Package Manager in one of two ways:

- In the SAP Easy Access menu, choose the path:
  - Tools > ABAP Workbench > Utilities > Maintenance > Support Package Manager
- Enter the transaction code SPAM.

Features

Support Package Manager offers you the following features and functions:

- **Loading Support Packages [page 16]:**
  You can load Support Packages into your system from SAP Support Portal or from collection CDs.

- **Importing Support Packages [page 13]:**
  - Restart capability
    When importing a Support Package into your system, Support Package Manager follows a predefined sequence of steps.
If the Support Package import process terminates, you can resume it later. Processing resumes at the step that where it terminated.

- **Displaying the import status**
  You can use Support Package Manager to find out the import status of your system at any time.

- **Special import procedure**
  You can minimize the downtime with a special import procedure. (See also: Import Mode: Downtime-minimized [page 32])

- **Start time definition**
  The various phases in Support Package Manager are condensed into modules. You are free to choose any start time you want for these modules.

- **Background Processing**
  You can also schedule the modules with defined start times for background processing.

You need Support Package Manager in order to perform an SAP upgrade.

### 1.1 General Description of the Import Process

All activities executed by the import tool run in phases. These phases are combined into modules.

Modules have the following properties:

- They can be executed individually
- You can start them as a background process
- You can control the start time of the module.

The import process is divided into the following modules:

**Preparation Module**

All the preparatory and test steps (including the test import and add-on conflict check) are performed in this module. This module can run during production operation.

After performing the Preparation module, you can reset or delete the queue. If you continue with module Import 1, data in the database is changed, and you can no longer reset or delete the queue.

---

**Note**

For more information about the check steps in the module Preparation, see Checks While Importing a Queue [page 51].

**Module Import 1**

This module executes the import of dictionary objects and, if required, modification adjustments. When using the Downtime-minimized import mode, the inactive import of program code and program texts also takes place. The changes that result from dictionary imports and inactive imports are still in an inactive state in the system. The runtime system is still unable to "see" these changes. If you are sure that no manual changes are being made, and that no transports are being imported into the system, this module can also run during production operation. This is normally the case in production systems.

**Module Import 2**
The remaining import steps (dictionary activation, main import, after-import method execution, and so on) are executed in this module. Since the changes are imported in different transport objects and the system is temporarily inconsistent, no productive operation should take place while this module is in process.

**i Note**

There are software components whose installation or update does not slow down the production operation of a system, for example, the Solution Manager plug-in components ST-PI and ST-A/PI. If the queue contains only OCS packages of components whose manufacturers have confirmed that the production operation is not slowed down, the **Import 2** module can also be run during production operation.

**i Note**

If you are using a CRM system and importing CRM-relevant packages, you need to perform manual steps in the module **Import 2**. For more information, see Importing CRM Support Packages [page 15].

**Clean Up Module**

All cleanup steps are performed in this module. The most important of these is the adjustment of modifications in the repository objects. When all modifications have been adjusted, production operation may resume.

Since the package import process can be stopped after each module, modules **Preparation** and **Import 1** can run during productive operation. After the system has switched to non-productive operation, as scheduled, module **Import 2** and, if required, the modification adjustment can be performed. Productive operation can then resume.

**⚠️ Caution**

In the time between **Preparation** and **Import 2**, no transports can take place (apart from the modification adjustment transport, if required) and no manual changes can be made to repository objects (ABAP programs, Dictionary objects).

### 1.2 Authorizations

To use all the functions in Support Package Manager, you need authorization profile **S_OCS_STD**.

**Use**

If you log on in client 000, and your user master data contains the corresponding authorization profile, you can use all the functions in Support Package Manager. If you log on in a different client, or without the correct user profile, you can only use the display functions.

Only assign this authorization profile to users with responsibility for importing Support Packages, such as system administrators.
1.3 Support Packages: Types

A Support Package contains quality improvements for the SAP system or makes necessary adjustments, for example, due to legal changes. The objects in question are replaced in your system.

Each Support Package is valid for only one release (but for all databases and operating systems) and requires an exactly defined number of predecessors. The upgrade in the following release or correction contains all the Support Packages from previous versions that were available up to the delivery of the upgrade.

Support Package Manager makes sure that Support Packages are imported in the specified order.

To prevent errors, import Support Packages at regular intervals. This keeps your system landscape up to date.

The following Support Package types are offered:

- **SPAM/SAINT Update**
  A SPAM/SAINT Update (PAT) contains updates and improvements to Support Package Manager and SAP Add-On Installation Tool.

- **Component Support Package**
  A Component Support Package (CSP) is valid for one software component (such as `SAP_BASIS`, `SAP_HR`, `SAP_APPL`, or Add-On Software Component) and contains quality improvements for repository and dictionary objects in this software component only.
  Support Packages for the `SAP_HR` component also contain adjustments resulting from legal changes.

**Naming Conventions**

Some Naming Conventions for Support Packages

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_APPL</td>
<td>APPL Support Package</td>
</tr>
<tr>
<td>SAP_BASIS</td>
<td>Basis Support Package</td>
</tr>
<tr>
<td>SAP_ABA</td>
<td>Application Interface Support Package</td>
</tr>
<tr>
<td>SAP_HR</td>
<td>HR Support Package</td>
</tr>
<tr>
<td>SAP_BW</td>
<td>BW Support Package</td>
</tr>
<tr>
<td>BBPCRM</td>
<td>BBP/EBP and CRM Support Package</td>
</tr>
</tbody>
</table>

- **Conflict Resolution Transport**
  A Conflict Resolution Transport (CRT) is used only in add-ons, such as IS-H or IS-OIL. It is used to adjust Support Packages for an add-on.

**Note**

A CRT that is valid for an add-on release also contains all adjustments for earlier releases of this add-on. A CRT can also contain other quality improvements for the add-on in question. A CRT can also be a special Component Support Package for an add-on software component.
1.4 Support Package Manager Settings

These general settings for Support Package Manager influence the behavior of the system when loading and importing various types of Support Packages. SPAM/SAINT updates are an exception, as certain default settings cannot be changed.

General settings for Support Package Manager can be defined by choosing [Extras ➤ Settings]. You only have to define these settings once. They are saved and can be used each time you call Support Package Manager.

**Note**
Note that these settings also apply to SAP Add-On Installation Tool. One exception is the setting for import mode Downtime-minimized. This does not apply automatically to Add-On Installation Tool.

You can set or check the following attributes.

**Tab Page: Load Packages**

- **Directory on Application Server**
  You can check which application server directory the Support Packages are located in.

- **Load CAR/SAR archives from front end**
  - **Display Content Before Decompressing**
    You can decide whether to display a dialog box with the contents of the CAR/SAR archive before decompressing it. This is the default setting.
  - **Delete Archive After Decompressing**
    You can choose whether to delete the CAR/SAR archive transferred to the application server after decompressing it. This is the default setting.
  - **Check Archive Signature**
    You can specify whether the digital signature of the SAR archive created by SAP is to be checked. We strongly recommend that you switch on this option; this is the default setting.
  - **Save Last Upload Directory**
    You can decide whether to save the most recently used upload directory from your front-end host. This directory then appears automatically as the start directory in the archive selection dialog box next time round. This is the default setting.
    You can enter an upload directory of your choice in the Upload Directory field. This upload directory then appears as the start directory in the archive selection dialog box.

**Tab Page: Defining a Queue**

- **Queue Calculation Initial Screen**
  You can specify the queue calculation method that you want to be provided with by default upon entering the queue definition screen.
  - **Queue calculation for a vector of software components**
    The Support Package queue calculation takes place for multiple software components based on the target Support Package level that has been defined for each software component (see Defining a Queue Based on Multiple Software Components [page 22]).
  - **Queue calculation for one software component**
The Support Package queue calculation takes place by selecting one software component and the highest Support Package for this software component (see Defining a Queue Based on a Software Component [page 20]).

- **Including the Modification Adjustment**
  You can specify whether you want the system to always check the queue definition for modification adjustment transports that are to be included.
  - **Include adjustment transports**
    For the queue definition, the dialog box for including adjustment transports is always displayed.
  - **Do not include adjustment transports**
    No adjustment transports are included in the Support Package queue. The corresponding dialog box is not displayed automatically.
  - **Always ask**
    When defining the queue, the system asks you whether to include adjustment transports or not. You can then decide whether the dialog box for including adjustment transports is to be displayed or not.

- **Filtering the Component List**
  You can filter the software components using different criteria. This improves the overview of the software component list for the queue definition. You can adapt the standard settings and your requirements.
  - **Displaying Inactive Software Components**
    As of SAP NetWeaver 7.0, SAP also delivers the Switch Framework with which you can activate individual software components by activating the related Business Function Set in the Switch Framework as required. This means that not all the software components installed in, for example, an ERP 6.0 system are active. Industry-specific enhancements, such as ECC-DIMP and IS-OIL are inactive as standard. Since support packages do not necessarily have to be imported for inactive software components, you can hide these components in the component list of the queue definition as standard.
    If you deselect this checkbox, the system does not display the inactive components.
  - **Displaying Unused Subcomponents**
    Some software components were divided into subcomponents that form the entire scope of the master component (originally software component). An example for this is the division of software component SAP_HR into country-specific subcomponents. Support Packages only have to be imported for those subcomponents that are actually used. You can hide the unused subcomponents from the component list of the queue definition.
    If you deselect this checkbox, the system does not display the subcomponents that you have selected as **Unused** using the **Subcomponents** pushbutton.
    - **Subcomponents pushbutton**
      You can specify which of the subcomponents are not used.

  **i Note**
  When creating the subcomponents automatically, the system takes which country-specific functions are used for the SAP_HR software component from the previous use of the function and shows these as **Used**. You can change this setting.

**Tab Page: Importing a Queue**

- **Scenario**
  When choosing the scenario, you determine which activities you want to be performed when the Support Package is imported.
  - **Standard**
    You use the standard scenario to import Support Packages completely. All steps are performed.
○ **Import Mode Downtime-Minimized**
   If you choose the standard scenario, you can also choose the Downtime-minimized import mode to reduce the downtime. In the default setting, this option is deactivated. The packages are imported using the conventional import method.

   **i Note**
   To find the best import mode for your system, check the prerequisites under Import Mode: Downtime-Minimized [page 32].

○ **Test**
   Use the test scenario to determine if a modification adjustment is required before the Support Package is actually imported, or if any conflicts need to be resolved before the import. The test scenario does not import data into your SAP system.
   There is no test scenario for SPAM/SAINT updates. A SPAM/SAINT import ignores the scenario you select.

- **Number of parallel processes for each R3trans**
   You specify the number of parallel processes that are started by R3trans to import transport request data into the database. We recommend you set this to a maximum of 5.
   For more information about this R3trans function, see SAP Note 1127194. To avoid known problems with this function, use the version of R3trans from at least December 19, 2008.
   This option affects the import of all Support Packages imported with the Support Package Manager.

- **Handle the R3trans Data Files**
  - **Delete data file after import**
    You can determine whether to delete the data files after the Support Packages have been imported. This saves hard disk space and is the default setting.
    If you use a multiple system landscape with a common transport directory, it is best to deactivate this option. This saves you from having to create new data files in the other systems.

- **Checks During Import**
   Different checks are executed in the individual import phases when importing a queue to ensure that the import is successful and that the system remains consistent. Some of these checks can be deactivated without risk according to system environment and configuration.

  ○ **Check for Active User DDIC**
    Individual import steps are processed by background jobs in the ABAP system (DDIC activation for example). These background jobs usually run under user DDIC. To avoid problems when processing these background jobs, the system checks whether user DDIC exists in the system and is active.
    Since user DDIC can pose a security threat, it is possible to set a different user to process the import steps via the configuration page in the transport system. For more information, see the section dealing with the transport system in the SAP NetWeaver Security Guide, under https://help.sap.com/nw Sap NetWeaver Platform > <your release version> > Security > SAP NetWeaver Security Guide. In this case, deactivate the check for user DDIC.

  ○ **Check the Requests to be Imported in Transport Management System (TMS)**
    When importing an Support Package queue, it is checked before the physical import of the Support Package if the import queue in TMS contains requests that have to be imported before importing the Support Package. This check takes place only on the basis of the request attributes that contain the installed software component versions of the export system at the time of the export. If this check finds that the system status after the import of the Support Package queue no longer matches the status of the export system, then a warning is displayed about performing a transport for the previous import.
However, this check does not take the content of the transport requests into consideration, which means it is not checked if there is an actual collision with the Support Packages to be imported. This means the check result is only ever a recommendation which can be ignored while importing the Support Package.

It can make sense in some constellations to deactivate this check entirely, for example, if the transport requests only contain customer-owned objects that do not collide with SAP Support Packages or if Change Management Tools (for example, CHARM in Solution Manager) are used to ensure system changes are executed in the correct order.

- **Check the Signature of OCS Packages to be Imported**
  You can specify if you want the system to check the digital signature (of the OCS packages to be imported) during the import phase. This is the default setting.

  ![i Note]
  SAP Note [2520826](https://support.sap.com) is required to run this check. If this note has not been imported, the check is not performed.

- **Create Object Versions During Import**
  This option does not apply to SPAM/SAINT updates.
  You can choose to create versions of the objects in the Support Packages in the queue when they are imported. This option is deactivated by default, since it only makes sense to do this if version creation is active for all imports. This can take a long time and uses up a lot of space in the database.

  ![i Note]
  If version creation is activated in the configuration of the transport tools in the Transport Management System (transaction STMS), parameter VERS_AT_IMP must be set as ALWAYS.

- **ABAP/Screen Generation**
  Select this option if you want the programs and screens delivered in the Support Packages to be generated when they are imported. You cannot change the generation settings for SPAM/SAINT updates.

  - **Never Execute**
    If you set this option, the programs and screens are generated only when called for the first time.

  - **Always Execute**
    If you set this option, the programs and screens are always generated. Note that generation can take a long time and may cause errors.

  - **According to SAP Instructions**
    If you choose this option, the programs and screens are generated if the option for generating them while importing these Support Packages has been activated by SAP.

**Tab Page: Runtime Analysis**

- **Sending a Runtime Analysis and Feedback Form**
  When you confirm a queue, a dialog box opens in which you can specify whether you want to send a runtime analysis and feedback form to SAP. Deselect this option if you want to hide the dialog box.

- **Default Values for the Feedback Form**
  You use these options to specify which information is added to your feedback form by default.

- **System Type**
  You use this option to specify whether your feedback applies to, for example, your development system, quality assurance system, or production system.

- **Contact/E-Mail Address**
  You use this option to enter an e-mail address as your default contact address in the feedback form.
## Default Settings in Support Package Manager

<table>
<thead>
<tr>
<th>Option</th>
<th>Global Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Content Before Decompressing</td>
<td>On</td>
</tr>
<tr>
<td>Delete Archive After Decompressing</td>
<td>On</td>
</tr>
<tr>
<td>Check Archive Signature</td>
<td>On</td>
</tr>
<tr>
<td>Save Last Upload Directory</td>
<td>On</td>
</tr>
<tr>
<td>Queue Calculation Initial Screen</td>
<td>Calculation for a component vector</td>
</tr>
<tr>
<td>Including Modification Adjustment Transports</td>
<td>Always ask</td>
</tr>
<tr>
<td>Displaying Inactive Software Components</td>
<td>On</td>
</tr>
<tr>
<td>Displaying Unused Subcomponents</td>
<td>Off</td>
</tr>
<tr>
<td>Scenario</td>
<td>Standard</td>
</tr>
<tr>
<td>Import mode</td>
<td>Downtime-minimized</td>
</tr>
<tr>
<td>Number of parallel processes for each R3trans</td>
<td>1</td>
</tr>
<tr>
<td>Delete Data File After Import</td>
<td>On</td>
</tr>
<tr>
<td>Check on active DDIC user</td>
<td>On</td>
</tr>
<tr>
<td>Check for requests to import in TMS</td>
<td>On</td>
</tr>
<tr>
<td>Check digital signature</td>
<td>On</td>
</tr>
<tr>
<td>Create Object Versions During Import</td>
<td>Off</td>
</tr>
<tr>
<td>ABAP/Screen Generation</td>
<td>Never Execute</td>
</tr>
<tr>
<td>Send Runtime Analysis Form</td>
<td>On</td>
</tr>
</tbody>
</table>


2 Importing Support Packages with Support Package Manager

You can use Support Package Manager to import Support Packages into your system, irrespective of whether they are from SAP Support Portal or from Collection CDs.

Prerequisites

- **User:**
  - You have the relevant authorizations in Support Package Manager.
  - You are logged on in client 000.
  - You have called Support Package Manager.
    The initial screen provides an overview of the status of the last queue imported. If the Support Package import is incomplete, the last (terminated) phase processed by Support Package Manager is displayed.

- **System:**
  - You have checked that the transport tools work correctly by choosing `Utilities ➤ Check Transport Tool`.
  - You have ensured that there is enough space in the transport directory (size of the files multiplied by 2). (See the SAP profile parameter `DIR_TRANS` by using the transaction code `AL11` or `SE38` and the program `RSPARAM`). It is particularly important that there is enough space in subdirectories `trans/EPF/in` and `trans/data`.
  - You have imported the most recent SPAM/SAINT update.
    To do this, you have checked whether the SPAM/SAINT update in SAP Support Portal is newer than the one in your system. (The version of the SPAM/SAINT update in your system appears in the title bar of the Support Package Manager screen).

→ Recommendation

To avoid problems while importing Support Packages, always import the most recent SPAM/SAINT updates first.

- You must not have any incompletely imported Support Packages in your system.
  To check this, you have called transaction SPAM, selected `Terminated Support Packages` under `Directory` and chosen `Display`. No Support Packages should appear. The status should display a green light.
  If this is not the case, look at the detailed status and log information for all Support Packages found in the system. For this, under `Directory` choose `All Support Packages ➤ Display` or in the menu `Goto ➤ Status` or `Goto ➤ Log`. 
Activities

1. Loading Support Packages
2. Defining a Queue
3. Importing a Queue
4. If necessary: Adjusting Modifications
5. Checking Logs
6. Confirming the Queue

2.1 Importing a SPAM/SAINT Update

A SPAM/SAINT update (abbreviated to SPAM update) provides enhancements and improvements for the Support Package Manager (transaction code SPAM) and the SAP Add-On Installation Tool (transaction code SAINT).

Prerequisites

You can only import a SPAM update if there are no terminated packages in the system.

A dialog box informs you if there are any terminated packages. You then have two options:

- Import the entire queue to begin with and then the SPAM update.
- Delete the queue, import the SPAM update, then import the queue.

**Note**

You can only delete the queue if module Import 1 has not yet started (up to phase SCHEDULE_RDDIMPDP).

Context

There is always one SPAM update for each release. This update is updated accordingly. To find out which version you are using, look at the following in your system:

- Short description, for example: **SPAM/SAINT Update - Version <REL>/0001**
- In the package name, for example: **SAPKD<REL>01**

The latest SPAM update is also available on SAP Support Portal, under [https://support.sap.com/swdc](https://support.sap.com/swdc).
→ Recommendation
Make sure you always have the most recent SPAM update before importing Support Packages or Installation Packages.

i Note
All of the functions and menu paths specified in this document relate to the Support Package Manager (transaction code SPAM). You can only import a SPAM/SAINT update with this transaction.

Procedure

1. Check if the SPAM update offered is newer than the one in your system. (The current SPAM/SAINT version is displayed in the title bar of the Support Package Manager.)

2. To import the most recent SPAM update, choose Support Package Import SPAM/SAINT Update. SPAM/SAINT updates are automatically confirmed once they have been imported.

2.2 Importing CRM Support Packages

The import process with SAP Add-On Installation Tool contains CRM-specific phases that run only if the package to be imported contains CRM-relevant data and is to be imported into a CRM system.

i Note
If you want to import CRM Support Packages into a CRM system, you can use SAP Add-On Installation Tool (transaction SAINT) instead of CRM Add-On Manager (transaction ADDON_MANAGER).

The steps described in the following are executed only in the CRM scenario. They run automatically in phases of the module Import 2, however the process stops when user interaction is required. This means that the full import process for CRM support packages takes place during downtime.

For a complete description of all phases of the import process, see the Phases section in this documentation.

CRM-Specific Preparation Steps
- Inbound queues are logged off.
- Replication and realignment queues are stopped.
- It is checked whether there are unprocessed BDoc messages. If there are BDoc messages that have not been processed completely, you are prompted to switch directly to the corresponding maintenance transaction to process these messages completely.
- CRM runtime objects are locked.

CRM-Specific Postprocessing Steps
- The generation of runtime objects is unblocked.
You are prompted to adjust the CRM Adapter Repository tables.

If there are inconsistent BDoc messages, you need to adjust the corresponding BDoc message manually.

Changed runtime objects are regenerated. If you have not yet planned a job for regenerating runtime objects, the import process is stopped and you have the option of starting the regeneration of runtime objects manually or creating a job.

The replication and realignment queues are started again.

The inbound queue is logged on again.

2.3 Loading Support Packages

You have to load Support Packages before you can import them.

Use


Prerequisites

- The Change and Transport System is configured correctly.
- There is enough space in the transport directory (UNIX: /usr/sap/trans).
- You have the relevant authorizations [page 6] for Support Package Manager.
- You are logged on in client 000.
- You have called Support Package Manager (transaction SPAM).
- You are using the latest version of Support Package Manager.

Activities

Loading Support Packages from the Application Server [page 17]

Loading Support Packages from the Front End [page 18]
2.3.1 Loading Support Packages from the Application Server

You want to load Support Packages from SAP Support Portal or from Collection CDs or DVDs from the application server, so that you can import them with Support Package Manager.

**Context**

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the archives are on your front-end host, you can copy them directly from Support Package Manager to the application server, and decompress them (see Loading Support Packages from the Front End [page 18]). However, if the archives are larger than 200 MB, proceed as described below.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Load the support packages from SAP Support Portal or mount the relevant CD or DVD. Copy the SAR archive with the support packages to the EPS download area of your transport directory (Unix and IBM system: /usr/sap/trans/EPS/download; Windows: <DRIVE>:\usr\sap\trans\EPS\download).

2. Load the Support Packages into your system by choosing **Support Package ▶ Load Packages ▶ SAR Archive from Application Server**.

   If this option is selected, the SAR archives are automatically unpacked and the contained EPS files are placed in the EPS inbox of your transport directory (Unix and IBM system: /usr/sap/trans/EPS/in; Windows: <DRIVE>:\usr\sap\trans\EPS\in).

   By default, the digital signature of the SAR archives is checked and a signed manifest is stored in the EPS inbox for each unpacked EPS file. These signed manifests are used later on during the import process, to check the integrity of the EPS data again.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you load the support packages using option <strong>EPS Files from Application Server</strong>, you first need to manually unpack the packages. To do this, log on to your system as &lt;sid&gt;adm and then go to the directory /usr/sap/trans (UNIX and IBM System i) or &lt;DRIVE&gt;:\usr\sap\trans (Windows). Unpack the archive containing the support packages using the following command:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX</td>
<td><code>SAPCAR -xvf /&lt;CD_DIR&gt;/PATH/&lt;ARCHIVE&gt;.CAR</code></td>
</tr>
<tr>
<td>IBM System i</td>
<td><code>SAPCAR ' -xvf /QOPT/&lt;VOLID&gt;/PATH/&lt;ARCHIVE&gt;.CAR</code></td>
</tr>
</tbody>
</table>
### Operating System

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>SAPCAR -xvf &lt;CD_DRIVE&gt;:&lt;PATH&gt;&lt;ARCHIVE&gt;.CAR</td>
</tr>
</tbody>
</table>

Since no signed manifests are created for the EPS files during manual unpacking, this option should only be used in exceptional circumstances. Instead, you should use the options to directly upload the SAR archives.

The system displays a list of the uploaded Support Packages that are now known in the SAP System together, together with their attributes. These can now be handled correctly by Support Package Manager.

3. To return to the initial screen in Support Package Manager, choose **Back**.

### Next Steps

**Defining the Queue** [page 19].

### 2.3.2 Loading Support Packages from the Front End

You want to load archives (*CAR/*SAR) from the front end to the application server so that you can use Support Package Manager to import the relevant Support Package.

### Context

**Note**

If these archives are smaller than 200 MB, proceed as described here. If the archives are larger than 200 MB, the procedure described here is not recommended. If this is the case, proceed as follows **Loading Support Packages from the Application Server** [page 17].

### Procedure

1. Call Support Package Manager using transaction **SPAM**.
2. Choose **Support Package > Load Packages > SAR Archives from Frontend**. The system displays an archive selection dialog box.
3. Select the relevant archive.
   
   This archive is copied to the application server. Then the digital signature of the archive is checked and the system reads the table of contents. The result of the signature check and the list of files contained in the archive is then displayed in a dialog box.
Archives provided by SAP are signed digitally, so the check must be successful. If a check with errors is displayed, do not use this archive. Load the archive from SAP Support Portal again, or contact SAP to clarify the integrity of the archive.

Archives of independent software vendors are not usually signed. This is also displayed. Clarify with the software vendor how the integrity of the archives can be ensured.

### i Note
You can switch off the signature check and the display of the dialog box in the Support Package Manager settings [page 8].

4. To unpack the files contained in the archive and inform the system, choose **Decompress**.

The signature manifest additionally contained in a signed archive (SIGNATURE.SMF) is also unpacked and stored in the EPS inbox under the name of the EPS file (*PAT file) contained in the archive. If the archive contains more than one EPS file, a specific manifest file is generated for each EPS file.

After you have decompressed the files, call Support Package Manager and choose **New Support Packages**, under **Directory**. Then choose **Display**. The new Support Package appears.

### Results
The archive has been copied to the application server and unpacked. The original archive has been deleted from the application server (see **Support Package Manager Settings** [page 8]).

### 2.4 Defining the Support Package Queue
You have to define the queue before importing Support Packages. The queue specifies which Support Packages Support Package Manager imports into your system, and in which order.

### Use
If the queue is not completely defined, you need to define the queue from the available Support Packages.

If the queue is already completely defined, it is only displayed; and you cannot change the selection. However, you can delete the queue in its entirety by choosing **Delete Queue** [page 63].

### Caution
You can only delete the queue if module **Import 1** has not yet started (up to phase **SCHEDULE_RDDIMPDP**).

Support Package Manager makes sure that only Support Packages that are appropriate for your system appear in the queue. Support Packages that are meant for another release or add-on do not appear in the queue, even if you have loaded them into your SAP system. For more information, see **Rules for the Queue** [page 20].
Prerequisites

You have used the Support Package Manager to load the relevant Support Packages into your SAP System.

You must have distributed maintenance certificates in your system if you want to import SAP Support Packages. For further information, see the SAP Support Portal under http://support.sap.com/maintenancecertificate and in 1240265.

Activities

- Defining a Queue Based on One Software Component [page 20]
- Defining a Queue Based on Multiple Software Components [page 22]
- Defining a Queue Based on a Target Support Package [page 24]

2.4.1 Rules for the Queue

When creating a queue, the rules specified here apply.

- Support Packages for a selected component are placed in the queue in the correct order.
- If Support Packages in the queue are related to Support Packages for another component (additional predecessor relationship, Conflict Resolution Transport required), additional Support Packages are added to the queue until all the predecessor relationships are met.

⚠️ Caution

Make sure that Support Package Manager takes into account the configuration of your SAP System and only adds to the queue Support Packages that may be imported into your system.

2.4.2 Defining a Queue Based on One Software Component

You want to define a Support Package queue for a particular software component.

Procedure

1. In the initial screen in Support Package Manager, choose Display/Define.
   - If this queue calculation method has been selected as the default setting, the Component Selection dialog box appears.
   - Otherwise, you can display the Component Selection dialog box by choosing Individual Components.

A list of installed software components (for example, SAP_BASIS, SAP_HR, SAP_BW) is displayed.
2. You can filter the software component list according to various criteria.
   ○ In SAP ERP systems in particular, a variety of software components are installed that are not all active in the system. You can set for inactive components not to be displayed. To do this, select the selection symbol next to the pushbutton with the tooltip Display/Hide Filter and select Hide Inactive Components.
   ○ Some software components are divided into subcomponents. The subcomponents are hidden behind the related main components by default. To show all subcomponents, select the symbol with the tooltip Expand Subcomponent View before selecting the related main component. You can also set that unused subcomponents are not displayed. To do this, select the selection symbol next to the pushbutton with the tooltip Display/Hide Filter and select Hide Unused Subcomponents.
   ○ In the Settings for the Support Package Manager [page 8], you can configure standard filter settings. You can set this by selecting the Activate/Deactivate Filters pushbutton. You can branch directly to the standard filter settings using the selection list symbol next to the pushbutton.

3. Select the required components.

   The current queue appears. This queue contains the Support Packages available for the selected component in your system, and, if necessary, Support Packages of other components, Conflict Resolution Transports (CRTs) and other Add-On Support Packages.

   If you want to define the queue for another software component, choose Other Component.

   **Note**
   If errors occur during queue definition, read the queue calculation log [page 37].

4. You can now do the following:
   ○ You can limit the queue selection. To do this, select the Support Package that you want to be last in the queue. This recalculates the queue. You can also do this explicitly by choosing Recalculate Queue.

   **Note**
   You can only select Support Packages belonging to the software components that you have selected (the cursor changes its appearance accordingly). The Support Packages that belong to the queue are highlighted in green. The Support Packages that no longer belong to the queue are still visible in the list, from where you can select them again.

   ○ If the displayed queue meets your requirements, you can confirm it by choosing Confirm Queue and closing this window.

**Results**

You have defined the queue. You can now Include Modification Adjustment Transports [page 25] or Import Support Packages [page 27] contained in the queue.
2.4.3 Defining a Queue Based on Multiple Software Components

You want to define a Support Package queue for multiple software components.

Procedure

1. In the initial screen in Support Package Manager, choose Display/Define. If this queue calculation method has been selected as the default setting, a dialog box is displayed allowing you to define a queue for any components of your SAP system. Otherwise, choose All Components to display this dialog box.

2. You can filter the software component list according to various criteria.
   - In SAP ERP systems in particular, a variety of software components are installed that are not all active in the system. You can set for inactive components not to be displayed. To do this, select the selection symbol next to the pushbutton with the tooltip Display/Hide Filter and select Hide Inactive Components.
   - Some software components are divided into subcomponents. The subcomponents are hidden behind the related main components by default. To show all subcomponents, select the symbol with the tooltip Expand Subcomponent View before selecting the related main component. You can also set that unused subcomponents are not displayed. To do this, select the selection symbol next to the pushbutton with the tooltip Display/Hide Filter and select Hide Unused Subcomponents.
   - In the Settings for the Support Package Manager [page 8], you can configure standard filter settings. You can set this by selecting the Activate/Deactivate Filters pushbutton. You can branch directly to the standard filter settings using the selection list symbol next to the pushbutton.

3. On the Target Package Selection tab page, you need to select the highest Support Package that you want to import from the selection list for each component. By default, the highest available Support Package is displayed. If you do not want to import any Support Packages for a component, select the empty field from the selection list.

In addition to the manual selection of the Support Packages for each component, you can also define the required target status using a stack configuration. To do this, follow the procedure below:

1. In the selection list of the pushbutton Stack XML File, select the option Read from Frontend to upload a stack XML file from your front-end PC. Select the required XML file and confirm your selection by choosing Open. After the upload, the Support Package Manager checks if the selected stack configuration matches your system. If it does not, an error message appears.

2. If your current system is included in a Solution Manager landscape and the connection to the Solution Manager is configured (see Solution Manager IMG), the stack configurations calculated in the Maintenance Optimizer for your system can be read directly from the Solution Manager. In this case, select the Read from Solution Manager option. A dialog box opens, providing a list of configurations in Maintenance Optimizer that are available for your system. Select one and confirm your selection. After the transfer, the Support Package Manager checks if the selected stack configuration matches your system. If it does not, an error message appears. Ensure that the Read from Solution Manager option is inactive if no RFC connection to the Solution Manager is configured or if it is not working.

3. If the stack configuration matches your system and the available Support Packages, the Target Package fields of the software components contained in the stack configuration are set to the defined...
target Support Packages. In the selection lists of these software components, Support Packages that are lower than the target Support Packages required by the stack XML are no longer displayed. However, you can select higher Support Packages. The prerequisite for this is that these packages were uploaded to the system. The target Support Package selection is set to initial for software components that are not represented in the stack definition and an empty field is displayed. Here you also have the option to select higher target Support Packages from the selection list provided they have already been imported into the system. You can reset your target Support Package selections to the default using the Revoke Target Package function.

4. When you have selected the target Support Packages for all the components you require, choose Calculate Queue.

The system calculates the maximum possible queue using the chosen target Support Packages in the components you have selected.

The result of the queue calculation is summarized in Status/Comment. At the same time, the Support Package Level attained with the calculated queue is displayed for each component, and linked to the Support Package Level of the chosen target Support Package using a comparison symbol. This provides you with a rapid overview of the result of the queue calculation.

The queue calculation can have the following results:

○ The queue is consistent and corresponds completely to the target Support Packages that you have chosen.
○ The queue is consistent but does not correspond completely to the target Support Packages that you have chosen.

For certain components, the chosen target Support Package levels could not be attained using the calculated queue, or more Support Packages had to be included in the queue for a certain component than selected, in order to maintain consistency. Variances of this kind are often due to dependencies between Support Packages in different components that do not allow strict compliance with the target Support Package levels that you have chosen. This can happen if you need to include Conflict Resolution Transports (CRTs).

○ If the system is unable to calculate a consistent queue, it displays an error message to this effect. You can start by attempting to reduce the package selection. If this proves unsuccessful, you can also attempt to define the queue using a Target Support Package [page 24]. In this way, you can get detailed information about the error.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If errors occur during queue definition, read the queue calculation log [page 37].</td>
</tr>
</tbody>
</table>

5. You have the following options:

○ If the system has calculated a consistent queue, you can view and check it in detail in the Calculated Queue tab page.

○ To adjust the queue to your requirements, you can change the target package selection. Then choose Calculate Queue again.

6. If the queue is now how you want it, copy and confirm it by choosing Confirm Queue.
Results

You have defined a valid queue. You can now Include Modification Adjustment Transports [page 25] or Import Support Packages [page 27] contained in the queue.

2.4.4 Defining a Queue Based on a Target Support Package

You want to define a Support Package queue based on a particular target Support Package.

Procedure

2. Choose Display.

   The system displays a list of the Support Packages that are available in your system but have not yet been imported.
3. Place the cursor on the Support Package that you want to select, and choose Calculate Queue.

   The current queue appears. This queue contains the Support Packages available in your system that are needed for the required target Support Package, and, if necessary, Support Packages of other components, Conflict Resolution Transports (CRTs), and other Add-On Support Packages.
4. You can now do the following:

   - You can limit the queue selection. To do this, select the Support Package that you want to be last in the queue. This recalculates the queue. You can also do this explicitly by choosing Recalculate Queue.

     *i* Note

     You can only select Support Packages that belong to the software component of the target Support Package that you have selected (the cursor changes appearance accordingly). The Support Packages that belong to the queue are highlighted in green. The target Support Package is also flagged with a green check mark. The Support Packages that no longer belong to the queue are still visible in the list, from where you can select them again.

   - If the displayed queue meets your requirements, you can confirm it by choosing Confirm Queue and closing this window.

     *i* Note

     If the system cannot calculate a valid queue, an error message is displayed. For detailed error information, call the long text for the error message. If errors occur during queue definition, read the queue calculation log [page 37].

Results

You have defined a valid queue. You can now Include Modification Adjustment Transports [page 25] or Import Support Packages [page 27] contained in the queue.

2.4.5 Including Modification Adjustment Transports

If you have a multi-system landscape, you only need to perform the modification adjustment once. The system stores the data for the adjustment in transport requests that you can include in the import process when importing the Support Package queue into the follow-on systems.

Prerequisites

You have created, selected and released one or more modification adjustment transports in your system, following the method described in Performing Modification Adjustments [page 34].

Recommendation

For quality assurance purposes, we recommend that you always include modification adjustment transports in the Support Package queue, as manual adjustment actions in the follow-on system are then no longer necessary. If you are using the Import Mode Downtime-Minimized [page 32] then the total downtime is reduced.

Procedure

1. After you have defined a queue, the system asks you whether you want to include modification adjustment transports. Confirm that this is the case.

   Note

   In the Settings for the Support Package Manager [page 8], you can suppress this question.

   A dialog box appears, containing a list of existing modification adjustment transports.

   You can also call this dialog box by choosing Display/Define on the Support Package Manager initial screen, and then choosing Add Adjustment Transports to Queue in the dialog box of the current Support Package queue.

2. If no adjustment transports are displayed in the list, you need to notify the system of the transports. To do this, choose Find Adjustment Transports.

   You can also call the function for finding adjustment transports from the menu on the initial screen of the Support Package Manager, under Support Package ➤ Find Adjustment Transports.
The system searches for adjustment transports in the Transport Management System import queue and in the transport directory on the application server. The system lists the transport requests that you have selected as modification adjustment transports and released in the export system.

For each adjustment transport listed, the *Status* field shows whether or not it matches the current Support Package queue and can therefore be included. Adjustment transports that match the queue are already selected in the table. An adjustment transport "matches" the queue if the target Support Package status of the current queue is the same as the one in the export system at the time when the modification adjustment transport is exported.

3. If required, change the adjustment transport selection.
   - You cannot select adjustment transports that do not match the queue. To hide adjustment transports that do not match the queue, choose *Activate Filter*.

4. To add the adjustment transports to the Support Package queue, choose *Copy Selected Adjustment Transports*.

**Results**

You have added modification adjustment transports to a Support Package queue. You can now import this queue [page 27].

⚠️ *Caution*

When a modification adjustment transport is imported as part of a Support Package queue, it is deleted from the normal transport flow for Workbench requests. Requests are not forwarded to follow-on systems automatically.

If you are working with the classic three-system landscape comprising a development system (DEV), quality assurance system (QAS) and production system (PRD), the modification adjustment transport is put into the QAS import queue after being exported from the DEV system. Including the adjustment transport in a Support Package queue in system QAS deletes it from the QAS import queue. Since no transport forwarding takes place when importing a Support Package queue, the adjustment transport is not forwarded into the import queue of the PRD system. This means that the modification adjustment will not be imported to your PRD system with the Transport Management System.

You then need to import the adjustment transport into the PRD system as part of a Support Package queue, using the same procedure as in the QAS.

**Next Steps**

Importing Support Packages into Other Systems [page 43]
2.5 Importing a Queue

Once you have defined a queue, you can import it into your system.

Prerequisites

You have already defined the queue.

Context

Support Package Manager offers you two scenarios for importing Support Packages or queues:

- **Test scenario**
  Before starting the import process, use the test scenario to detect any conflicts or problems (for example, repairs that have not been released), or any requirement for modification adjustments. This scenario helps you to estimate and minimize the time and effort needed to import Support Packages. This scenario does not import any data into the system. If errors do occur, you can continue the import without correcting them. You must choose the test scenario explicitly.

  **Note**
  After the test scenario has run, the queue is empty, and you need to define it again. You then have to choose the standard scenario explicitly.

- **Standard scenario**
  The standard scenario imports all Support Packages in the queue. If errors occur, you have to resolve them before you can continue with the import. If you choose the standard scenario, you can also choose between the conventional import mode and Import Mode: Downtime-Minimized [page 32] to reduce the downtime.

Procedure

- **Importing a Queue in the Test Scenario**
  a. To set the test scenario, choose Extras > Settings.
  b. On the Import Queue tab page, choose Test and define the other settings [page 8] for the import.

  You can also use this function to restart a terminated import.

  The status line informs you of the progress of the test import and the current Support Package Manager phase. You may have to perform a modification adjustment during the import (with
transactions SPDD and SPAU). Note that the modification adjustment is only available in display mode. You can only perform it if you are importing the Support Packages in the standard scenario.

- **Importing a Queue in the Standard Scenario**
  a. To set the standard scenario, choose Extras Settings.
  b. On the Import Queue tab page, choose Standard and define the other Settings [page 8] for the import.
  c. Choose the import mode you require.
  d. Choose Support Package Import Queue.

You can also use this function to restart a terminated import.

e. A dialog box is displayed, where you can select the Start Options [page 30]. Define the start options you require and confirm the dialog box.

Support Package Manager continues processing with your chosen import mode and start options.

○ **Conventional Import Mode**
  If you have accepted the standard options without making any changes then the import starts after you have confirmed the start options. The Support Package Manager executes the entire processing in dialog. Since the whole import process is run through in this case without stopping, your system must already be non-productive at this time.

**Note**

To bring the system to a non-productive status in an orderly way, reschedule all scheduled background jobs using the report BTCTRNS1 and let any background jobs that are running complete, or terminate them manually. Prompt all users to close any transactions they are working in and to log off from the SAP system.

If you have selected a start time or Continue Manually for module Import 2, your system can stay in production operation until module Import 2 starts.

After starting the import, the program runs through a Support Package Manager. If errors occur in any of these phases, the import process terminates, and a description of the error is provided. When the problem is corrected, you can continue with the import.

Firstly, the Support Package Manager performs all the preparation and test steps (module Preparation). If any errors in this module cannot be resolved, you can reset the queue.

**Note**

For more information on the check steps in the Preparation module, see Checks when Importing a Queue [page 51].

Then it executes the import steps of the Import 1 and Import 2 modules.

**Caution**

Since the database is already changed in these phases, you cannot reset the import once the Import 1 module has started. You have to continue it after correcting any possible errors.

○ **Import Mode Downtime-Minimized**
  If you have accepted the default start options, your system can remain productive, as Support Package Manager tells you explicitly when to stop production operation.

Firstly, the Support Package Manager performs all the preparation and test steps (module Preparation). If any errors in this module cannot be resolved, you can reset the queue.
For more information on the check steps in the Preparation module, see Checks when Importing a Queue [page 51].

It then runs through the import steps that can be performed during production operation (module Import 1).

⚠️ Caution

Since the database is already changed in these phases, you cannot reset the queue once the Import 1 module has started. You have to continue the import after correcting any possible errors.

The development environment is blocked when module Import 1 starts, thus ensuring that modifications do not endanger the consistency of the system. Support Package Manager then displays a dialog box prompting you to stop production operation for the next import module (Import 2).

1. Set your system to a non-productive status.
   - For this, cancel any background jobs using the report BTCTRNS1 and, if necessary, allow any running background to complete, or terminate them manually. Prompt all users to close any transactions they are working in and to log off from the SAP system.

2. To continue the import, choose Support Package ➤ Import Queue. This module (Import 2) activates the inactively imported objects and imports the remaining objects from the Support Packages in the queue.
   Once this module has been completed, Support Package Manager informs you that you can restart production operation in your system.

   i Note

   This applies only if you have made either no or very few modifications to SAP objects. Otherwise the modification comparison must be executed before the productive status is restored.

f. If you have made modifications to SAP objects, Support Package Manager prompts you to perform a modification adjustment.

   You must adjust dictionary objects immediately (with transaction SPDD). As far as repository objects are concerned, you can either adjust them now or later (with transaction SPAU). To do this, proceed as described under Adjusting Modifications [page 34].

g. To complete the import process, choose Import Queue again.

During the next import module (Clean Up), post processing steps are performed. The installation process is complete.

   i Note

   You can restore productive status in parallel to this import module, or you can start with the preparation activities for restoring productive status (for example, execute ABAP Mass Generation with the SAP Load Generator [page 47]). You can schedule the previously canceled background jobs using the report BTCTRNS2.
2.5.1 Defining the Start Options

You can define start options for the individual modules according to your system requirements. If you confirm the dialog field without changing any settings, the import tool uses the default start options, in accordance with the selected import mode. If you change any settings, you can save them as a template for future import activities.

Prerequisites

- You have started importing the queue.
- If you want to perform the import in the background: You have ensured that your system has at least two free background processes and that no other background jobs will be executed at the same time.

Procedure

1. In the Start Options for the Queue dialog, you can select the options you require for each module from the relevant tab page:
   - Immediate start/continue in dialog immediately
     Choose this option if you want the module to be processed immediately in the dialog. If you select this option for multiple modules, they are processed consecutively without interruption. The mode is blocked for the duration of the import.
   - Immediate start/continue in background immediately
     Choose this option if you want the module to be processed immediately in the background. If you select this option for multiple modules, they are processed consecutively without interruption.
   - Later start/continue in background later
     Choose this option if you want to start the module in the background later. Select the required start date and time using input help. If you choose No Start After, the module is processed only in the period between Planned Start and No Start After. If no background processes are available during this time, the module is not processed.
   - Manual start/continue manually
     Choose this option if you want to process the module manually. The import tool interrupts the process after processing the previous module.

2. If you change the start option for a module, start options for other modules can be affected too. You can see an overview of the current start options for all modules in the summary in the upper part of the dialog sequence. The summary is usually automatically updated when changes are made. However, for certain changes (for example, if you enter a start time), the automatic refresh does not take place. In this case, use the Refresh function.

3. If you want to save your selection as a template for future import activities, choose Save As Template. The template is then used by default whenever the import process is started again in the same import mode. If you have stored a start time in a template, the module is processed only in the period between Planned Start and No Start After. If no background processes are available during this time, the module is not processed. You can only save the selected options as a template when starting a new queue import and defining the options for the entire import process. When restarting the import process after a module has been
processed or after an error has occurred, it is no longer possible to save the changed options as a template.

4. Confirm your selection by choosing **Continue**.

## Results

The import tool starts importing the queue using your start options.

If the import tool interrupts the processing procedure after processing a module, you can check the start options before the next module starts and change them if required. If you have scheduled modules to be processed in the background, you can only make changes using Job Administration. To do this, choose **Environment > Background Processing in the import tool**.

### Standard Settings for Unchanged Use of the Conventional Import Procedure

If you have chosen the conventional import (import mode **Downtime-minimized** is not activated), the following settings are made by default:

<table>
<thead>
<tr>
<th>Module</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation</td>
<td>Immediate Start in Dialog</td>
</tr>
<tr>
<td>Import 1</td>
<td>Continue in Dialog Immediately</td>
</tr>
<tr>
<td>Import 2</td>
<td>Continue in Dialog Immediately</td>
</tr>
<tr>
<td>Clean up</td>
<td>Continue in Dialog Immediately</td>
</tr>
</tbody>
</table>

### Standard Settings for Unchanged Use of the Import Mode **Downtime-minimized**

**i Note**

The import mode **Downtime-minimized** is only available for import-only processes. This means that the default settings of the regular import process apply to un installations and combined import and uninstallation processes.

If you have selected import mode **Downtime-minimized**, the following settings are made by default:

<table>
<thead>
<tr>
<th>Module</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation</td>
<td>Immediate Start in Dialog</td>
</tr>
<tr>
<td>Import 1</td>
<td>Continue in Dialog Immediately</td>
</tr>
<tr>
<td>Import 2</td>
<td>Continue Manually</td>
</tr>
<tr>
<td>Clean up</td>
<td>Continue Manually</td>
</tr>
</tbody>
</table>
2.6 Import Mode: Downtime-Minimized

The Downtime-minimized import mode was developed to reduce downtime when importing packages. It enables the majority of objects to be imported while the system is in production operation.

Use

Due to the size and extent of OCS packages (support packages, add-on installation packages, and add-on upgrades), importing packages entails lengthy system downtime. The system is not restarted here, however it should not be used in production operation during the import process. This restriction is often a disadvantage in production systems.

In the Downtime-minimized import mode, downtime can be reduced significantly if a package has a high percentage of program code and program texts (these objects can potentially be imported while the system is in production operation). This proportion is around 70-80% in SAP_BASIS and SAP_APPL support packages.

In the Downtime-minimized import mode, the objects are imported into the database in an inactive state, where they are largely 'invisible' to the system. The system can still be used in production operation.

The new procedure contains some actions (activation of the inactive objects) and organizational steps that were not in the old procedure. This lengthens the duration of the import process. The efficiency or time saved in the non-production phase over the conventional procedure partly depends on the proportion of inactively imported objects in the total imported data. The duration of other actions performed in downtime (such as after-import methods or XPRAs) also contributes to the time that can be saved.

i Note

Import the packages in queues that are as large as possible (ideally in a single queue).

Note that, in some cases, it is not possible to import support packages in a queue using Support Package Manager. For more information, check the OCS composite SAP Note for the current release. SAP Note 97620 contains an overview of the most important OCS SAP Notes.

Prerequisites

Temporary free space is required in the database, since the inactive objects exist in the database alongside the active versions.

A defined process that is triggered by Support Package Manager or SAP Add-On Installation Tool activates the objects later. However, since the inactive objects are not completely isolated from the system, parallel changes might cause unwanted activation and inconsistencies in the system.

Make sure of the following during the import:

- You have enough free space in the database.
→ Recommendation

We recommend around 1.5 times the size of the packages that you are importing.

<table>
<thead>
<tr>
<th>Database</th>
<th>Tablespaces/Dbspaces/Volumes Affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>PSAPES &lt;REL&gt;D</td>
</tr>
<tr>
<td>DB2 UDB</td>
<td>PSAPES &lt;REL&gt;I</td>
</tr>
<tr>
<td>Informix</td>
<td>psapes &lt;REL&gt;</td>
</tr>
<tr>
<td>SAP MaxDB</td>
<td>If necessary, create a new volume to extend the database (see also 34690)</td>
</tr>
</tbody>
</table>

- No other transport requests are imported at the same time.
- The development environment is not being used as a production environment.

Use the **Downtime-minimized import mode**:

- for installations and upgrades
- in production systems
- in test systems, if you want to test the expected downtime of the production system
  During the import, you must treat the systems like production systems (make no manual changes to program objects, no parallel imports from other transport requests).

Do **not** use the **Downtime-minimized import mode**:

- for uninstallations and combined import and uninstallation processes
- in development systems, or in systems where frequent imports are made (QA or test systems)
  The consistency of the system cannot be guaranteed during the import if manual changes are made to program objects at the same time, or if other transport requests are imported.
- to import support packages into BBP systems
  The additional pre-import and post-import steps in the special BBP Support Package Manager ensure that the whole import can be performed effectively during downtime.
- to import support packages into CRM systems
  The additional pre-import and post-import steps for CRM systems ensure that the whole import can be performed effectively during downtime.

**Activities**

- Support Package Manager
  - Support Package Manager Settings
  - Importing Support Packages with Support Package Manager
- SAP Add-On Installation Tool
  - Settings for SAP Add-On Installation Tool
2.7 Adjusting Modifications

If you have modified SAP objects, and these objects are imported with Support Packages, you have to adjust the objects when you import the Support Packages in order to prevent modifications from being overwritten again by the SAP objects. Transaction SPDD adjusts dictionary objects and transaction SPAU adjusts repository objects.

Prerequisites

- You have administrator authorizations for the modification adjustment.
- You know exactly which objects have been modified.
- Support Package Manager has prompted you to adjust modifications.
- Either you have not included any adjustment transports, or the ones you have included do not cover all the objects that need adjusting.

Context

If you have already performed the modification adjustment in a system (in a development system for example), you do not need to perform it manually in the follow-on systems (quality assurance and production systems). You can include the transport requests that you created for the modification adjustment (modification adjustment transports) in the Support Package queue. The modification adjustment then takes place automatically when the queue is imported. For more information, see the section Including Modification Adjustment Transports [page 25].

Modification Adjustment for Dictionary Objects - Transaction SPDD

Adjust all modifications before you continue with the import. If you do not do this, your modifications to the dictionary objects could be lost. This can lead to data loss. To do this, perform all the steps as described below:

Modification Adjustment for Dictionary Objects - Transaction SPAU

You have the following options:

- Adjust all modifications before continuing with the import. This is recommended if you only need to adjust a small number of objects. To do this, perform all the steps as described below:
- Perform the modification adjustment and the remaining phases in parallel. This is recommended if you need to adjust a large number of objects.

Note

This procedure is intended in particular for using Import mode: Downtime-minimized [page 32]. In the subsequent phase, Support Package Manager deletes versions of program code and program texts.
that have become obsolete. Since this can be a lengthy process, you can save time by adjusting your modifications in parallel (at the same time).

If you want to perform the import in parallel, choose Continue on the screen that prompts you to perform a modification adjustment. Then carry out steps 1 to 3 as described below.

**Procedure**

To perform the modification adjustment, proceed as follows:

1. To enable your developers to adjust modifications, go to Transport Organizer and create one or more transport requests that include tasks for the developers (see [https://help.sap.com/nw](https://help.sap.com/nw) > SAP NetWeaver Platform > [your release version] > Application Help > Library for SAP NetWeaver: Function-Oriented View > Solution Life Cycle Management > Software Logistics > Change and Transport System > Transport Organizer).

   → **Recommendation**

   We recommend that you create one transport request for adjusting dictionary objects and another for adjusting repository objects.

   → **Note**

   If you want to include the transport requests in the Support Package queue into the follow-on systems, create them as transportable workbench requests. If you do not do this, they cannot be exported from the system and therefore cannot be used in follow-on systems.

2. If you want to include the created request in the Support Package queue in the follow-on systems for an automatic modification adjustment, you must mark it as an adjustment transport.

   a. To do this, call transaction SPDD or SPAU and choose Utilities > Select for Transport.

      This function is also used to select modification adjustment transports for the system upgrade. If you have already performed a system upgrade, the system might prompt you to decide whether you want to select the adjustment transport for use in the upgrade or for use in importing a Support Package (OCS). Choose OCS.

   b. On the selection screen, choose one of the requests you created previously and confirm your selection.

      The transport request is now selected for use as a modification adjustment transport.

   c. If you have created several transport requests, repeat the process for all of them.

3. Ask the developers to adjust the modifications for their objects.
If you have not yet confirmed the queue, the developers can choose Extras Adjust Modifications in the Support Package Manager initial screen to call either transaction SPDD or transaction SPAU, depending on the context.

Once the adjustment is complete, the developers must release their tasks and inform you. Modifications can be adjusted in any client.

**Note**
You only need to perform the following steps if you did not continue importing the queue after being prompted to perform a modification adjustment.

5. View the status of the queue. To do so, choose Goto Status Queue.
   
   A screen appears, prompting you to perform a modification adjustment.
6. Choose Confirm Adjustment and confirm the prompt.
   
   You return to the Support Package Manager initial screen.
7. To continue the import process, choose Support Package Import Queue.

**Results**

Support Package Manager continues (transaction SPDD) or completes (transaction SPAU) the import process and displays the status.


**Caution**

Since the modification adjustment transport is a normal Workbench request, it is placed automatically in the import queue of the follow-on system during the export process, where it can be imported as normal. This import is only appropriate, however, if the relevant Support Packages have been imported into the follow-on system. For this reason, make sure the import is not performed too early. To do this, use the functions contained in the Transport Management Systems, such as project management, QA mechanisms, deleting the request from the import queue, and so on.

2.8 Checking Logs

There are a number of different types of logs in Support Package Manager, which can help you when analyzing errors.

Context

During queue definition, you can use the queue calculation log for troubleshooting purposes. After successfully importing the queue, you should always check the import log and the action log.

Queue Calculation Log

The queue calculation log displays detailed information for queue calculation. The log is structured hierarchically. The highest package occupies the highest position. This log provides you with various details, including the prerequisites for importing the package. You can thus determine which prerequisites have not been met, preventing successful queue calculation.

If analyzing the log does not solve your problem, you can save it, using the print function. You can then send a problem message to SAP and include the log as an attachment.

Import Log

The import log displays logs for Support Package Manager phases that are used by the transport control program tp.

Assigning the SPAM Phases to Log Files

<table>
<thead>
<tr>
<th>Phase</th>
<th>Log File</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISASSEMBLE_PATCH</td>
<td>Create cofile</td>
</tr>
<tr>
<td>TEST_IMPORT</td>
<td>Test Import</td>
</tr>
<tr>
<td>IMPORT_OBJECT_LIST</td>
<td>Command file import</td>
</tr>
<tr>
<td>CREATE_VERS_BEFORE</td>
<td>Object version creation</td>
</tr>
<tr>
<td>DDIC-IMPORT</td>
<td>Data Dictionary import</td>
</tr>
<tr>
<td>DDIC_ACTIVATION</td>
<td>Data Dictionary activation</td>
</tr>
<tr>
<td>INACTIVE_IMPORT</td>
<td>Inactive import of program code and program texts (only in the Downtime-minimized import mode)</td>
</tr>
<tr>
<td>IMPORT_PROPER</td>
<td>Import of transport steps that are independent of requests (dictionary distribution, activation of inactive runtime objects, and so on)</td>
</tr>
<tr>
<td>XPRA_EXECUTION</td>
<td>XPRA/method execution</td>
</tr>
<tr>
<td>ABAP_GENERATION</td>
<td>ABAP/Screen Generation</td>
</tr>
</tbody>
</table>
Meaning of the Return Codes

<table>
<thead>
<tr>
<th>Return Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 or 4</td>
<td>System information and warnings&lt;br&gt;Warnings are generally not critical for the system. You should still check them, however, since sequence errors can occur sometimes.</td>
</tr>
<tr>
<td>Greater than 4</td>
<td>Serious errors that must be corrected before you can successfully import the Support Package.</td>
</tr>
</tbody>
</table>

Action Log

The action log contains information about the actions that take place during the individual phases while importing the current queue. It also includes information about the point at which a phase was stopped, as well as detailed error information.

Procedure

- To display the logs for the current queue, choose `Goto <Menu Option>` on the initial screen in Support Package Manager.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Calculation Log</td>
<td>Queue Calculation Log</td>
</tr>
<tr>
<td>Import Protocols (logs)</td>
<td>Import Protocols (logs)</td>
</tr>
<tr>
<td>Action Log</td>
<td>Action Log</td>
</tr>
</tbody>
</table>

2.9 Confirming the Queue

Confirm that the queue has been imported successfully into your system. This allows you to import more Support Packages in future. You will not be able to import any more Support Packages if you do not confirm the queue.

Prerequisites

You have successfully imported one or several Support Packages.
i Note

If you have not yet confirmed Support Packages that have been imported successfully, you will be prompted to do this when you upgrade the system.

Procedure

- Confirm the successful import of the Support Packages into your system by choosing Support Package Confirm.
3 Displaying Additional Status Information

You can display additional status information about Support Packages, as well as their import status.

Displaying Support Packages in the System

To display the Support Package status of your system, select one of the following options under Directory and choose Display:

- **New Support Packages** (not imported yet)
- **Canceled Support Packages** (were not imported successfully)
- **Imported Support Packages** (were imported successfully)
- **All Support Packages**

A list appears with information about the selected Support Packages.

This list contains information about the software component, the import status, and the import date. It also contains information about dependencies for Support Packages. This means which Support Packages, software components, or add-ons have to be imported as a prerequisite before a certain additional Support Package can be imported.

**Note**

This list enables you to analyze errors in detail. You can manually check the import prerequisites in the tree display. You can determine why a queue could not be defined, for example. For more information, see Troubleshooting [page 47].

The following functions are also available:

- **Display additional information about a support package**
  Double-click the relevant support package to display the following information:
  - Name of the OCS package
  - Name of the EPS file
  - Required SPAM/SAINT version
  - SAP Note about the support package. You must read this before importing the support package. If an SAP Note exists for this Support Package, you can open it by choosing Display SAP Note.

- **Display Object List**
  The object list of a support package indicates which objects are contained in the support package and whether they have been imported.
  You can display the object list in Transport Organizer. To do this, position the cursor on a Support Package and choose Object List.

  **Note**
  You cannot display object lists for new Support Packages. You must have already started importing the Support Package.

- **Display Import Log**
  You can display an import log for a support package. It logs the Support Package Manager steps that use the transport control program tp.
To do this, position the cursor on the relevant Support Package and choose *Import Log.*
For more information, see: *Checking Logs [page 37]*

- **Defining a Queue Based on a Target Support Package**
  You can calculate a Support Package queue based on a target Support Package and define it for import.
  To do this, proceed as described under *Defining a Queue [page 19].*

  → **Recommendation**

  If the queue calculation based on a software component contained errors, we recommend that you calculate the queue based on a target Support Package. In this case, the display enables you to analyze errors in detail.

  Note, however, that you cannot select multiple software components if you use this method.

- **Updating Package Attributes**
  The import prerequisites for the Support Package are defined in the attributes. You do not usually need to make changes to the attributes for a Support Package. However, you can reload the attributes if you want to make sure that the attributes are up-to-date.
  To do this, position the cursor on the relevant Support Package and choose *Reload Package Attributes.*

- **Find Relationship in Tree**
  For a prerequisite Support Package, you can search for the corresponding Support Package in the tree to view its prerequisites.
  To do this, position the cursor on a Support Package under the prerequisite set, and choose *Find Relationship in Tree.*
  The system displays the corresponding position in the tree. The prerequisite Support Package is selected.

**Displaying the Support Package Level of the Installed Software Components**

You can display a compressed overview of the software components that are installed in your SAP system.

To display the software components and their corresponding package level, call Support Package Manager and from the *Status* menu, choose *Package Level.* A dialog box appears listing the installed software components and additional information.

If a software component is currently being edited by Support Package Manager or SAP Add-On Installation Tool, the status is indicated by the color:

- **Yellow:** Processing is at a non-critical stage (queue has just been defined, import is complete, for example)
- **Red:** Processing terminated or is at a critical stage (for example, dictionary import, main import). The system is temporarily in an inconsistent state.

**Displaying the Import Status**

To display the import status of a Support Package queue, call Support Package Manager and choose *Goto* > *Status > Queue.* A dialog box informs you whether the Support Package has been imported.

**Display Import History**

To display the history of all Support Package queues, choose *Goto* > *Import History > Queue* in Support Package Manager. An overview of the import history is displayed sorted by queue.

Alternatively you can sort the overview by package as follows:

- In the overview sorted by queues, choose *Package-Based Sort.*
- Choose *Goto > Import History > Package* in Support Package Manager.
The following data is displayed in the queue-based overview:

- Technical name of the queue
- Packages assigned to the queue
- Time at which the queue was defined
- Status of the queue
- Description of the processing status of the queue with time

The following data is displayed in the package-based overview:

- Technical name of the package
- Queues and transports assigned to the package
- Description of the package and time at which the associated queues were defined
- Status of the package and status of the associated queues
- Description of the processing status of the package and the associated queues with times

The following additional functions are provided in both the package-based overview and the queue-based overview:

- **Display Object List**
  You can display the object list that belongs to a Support Package in the Transport Organizer. To do this, position the cursor on a package and choose **Object List**.
  The object list indicates which objects are contained in the package and whether they were imported and activated.

- **Display Action Log**
  To display the action log of a queue, position the cursor on a queue and choose **Action Log**.
  The action log contains information about the actions that take place during the individual phases when importing a queue. It also includes information about the point at which a phase was stopped, as well as detailed error information.

- **Display Import Log**
  To display the import log of a package, position the cursor on a package and choose **Import Logs**.
  The import log displays logs for Support Package Manager phases that are used by the transport control program t.p.

- **Display Runtime Analysis**
  To display the runtime analysis of a queue, position the cursor on a queue and choose **Show the runtime analysis of the queue import**.
  The runtime analysis indicates how much time was required by each import phase and how many import retries took place.

- **Find Relationship in Tree**
  For a prerequisite Support Package, you can search for the corresponding Support Package in the tree to view its prerequisites. To do this, position the cursor on a Support Package and choose **Find Relationship in Tree**.
  The system displays the corresponding position in the tree. The prerequisite Support Package is selected.
4 Importing Support Packages into Other Systems

Prerequisites

- You have imported the Support Packages successfully into a system (test or development system).
- If necessary: You have adjusted any modifications.

Procedure

1. Load the Support Packages into the next system (quality assurance or production system). You must differentiate between the following situations:

   ○ Your systems have a common transport directory:
     
     Call Support Package Manager in the target system and choose [Support Package] [Load Packages]
     
     From Application Server.

   ○ Your systems do not have a common transport directory:
     
     1. Using ftp in binary mode, copy all files with the extension *.PAT from the directory /usr/sap/trans/EPS/in (UNIX and IBM system i) or <DRIVE>:\usr\sap\trans\EPS\in (Windows) of the source system to the transport directory of the target system.
     
     2. Call Support Package Manager in the target system and choose [Support Package] [Load Packages]
        
        From Application Server.

2. Define the Support Package queue.

3. Include the modification adjustment transports that were created in the first system in the queue.

4. Import the Support Packages queue as usual.

Next Steps

Including Modification Adjustment Transports [page 25]
5 Phases

In the status bar, Support Package Manager informs you of the status of the current phase.

i Note
To find out which phases are executed for which scenario (test or standard scenario), run program RSSPAM10.

The following list provides an overview of all the modules and phases in the order in which Support Package Manager executes them:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation Module</td>
<td>Prologue</td>
</tr>
<tr>
<td></td>
<td>This phase checks whether you are authorized to import Support Packages.</td>
</tr>
<tr>
<td>CHECK_REQUIREMENTS</td>
<td>This phase checks various requirements for importing a Support Package, for example, whether transport control program tp can log on to your system.</td>
</tr>
<tr>
<td>DISASSEMBLE</td>
<td>This phase unpacks files from the appropriate EPS parcels and saves them to the transport directory.</td>
</tr>
<tr>
<td>ADD_TO_BUFFER</td>
<td>This phase adds the queue to your system's transport buffer.</td>
</tr>
<tr>
<td>MODIFY_BUFFER</td>
<td>This phase prepares the transport buffer so that the subsequent import phases can be processed correctly.</td>
</tr>
<tr>
<td>IMPORT_OBJECT_LIST</td>
<td>This phase imports the object lists for the Support Packages in the queue into the system.</td>
</tr>
<tr>
<td>TEST_IMPORT</td>
<td>In this phase, a test import is run for the current queue with transport control program tp. The system checks for objects that are in open repairs and that are overwritten during the import, or for other factors that might prevent an object being imported.</td>
</tr>
<tr>
<td>OBJECTS_LOCKED_?</td>
<td>This phase checks for objects that are overwritten by the import and are in requests that have not yet been released.</td>
</tr>
<tr>
<td>CHECK_INACT_OBJECTS</td>
<td>In this phase it is checked if there are still objects that are inactive.</td>
</tr>
<tr>
<td>ADDON_CONFLICTS_?</td>
<td>This phase checks for conflicts between objects in the queue and installed add-ons.</td>
</tr>
<tr>
<td>SCHEDULE_RDDIMPDP</td>
<td>This phase schedules the transport daemon (program RDDIMPDP).</td>
</tr>
<tr>
<td>Phase</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Module Import 1</strong></td>
<td></td>
</tr>
<tr>
<td>CREATE_VERS_BEFORE</td>
<td>This phase generates versions of the objects that are contained in the Support Packages in the queue (if this option is set).</td>
</tr>
<tr>
<td>SPDD_SPAU_CHECK</td>
<td>In this phase, the system checks whether a modification adjustment is necessary (transactions SPDD/SPAU).</td>
</tr>
<tr>
<td>DDIC_IMPORT</td>
<td>It imports all ABAP Dictionary objects in the queue.</td>
</tr>
<tr>
<td>AUTO_MOD_SPDD</td>
<td>It checks whether all modifications to ABAP Dictionary objects can be adjusted automatically.</td>
</tr>
<tr>
<td>RUN_SPDD_?</td>
<td>In this phase, you are asked to adjust your modifications to the ABAP Dictionary objects by calling transaction SPDD.</td>
</tr>
<tr>
<td>LOCK_EU (only in the Downtime-minimized import mode)</td>
<td>This phase locks the development environment.</td>
</tr>
<tr>
<td>INACTIVE_IMPORT (only in the Downtime-minimized import mode)</td>
<td>This phase imports program code and program texts in an inactive state.</td>
</tr>
<tr>
<td><strong>Module Import 2</strong></td>
<td></td>
</tr>
<tr>
<td>CRM_STOP_QUEUE_BDOCS</td>
<td>This phase is run only if you use a CRM system.</td>
</tr>
<tr>
<td></td>
<td>In this phase, replication and realignment queues are stopped, inbound queues are logged off, and BDoc messages are processed.</td>
</tr>
<tr>
<td>CRM_LOCK_RTME_GEN</td>
<td>This phase is run only if you use a CRM system.</td>
</tr>
<tr>
<td></td>
<td>In this phase, the CRM runtime objects are blocked.</td>
</tr>
<tr>
<td>DDIC_ACTIVATION</td>
<td>It activates the imported ABAP Dictionary objects.</td>
</tr>
<tr>
<td>IMPORT_PROPER</td>
<td>This phase imports all repository objects and table entries not already imported during phase INACTIVE_IMPORT. This is preceded by actions such as table conversion and activation of the name tabs.</td>
</tr>
<tr>
<td>PREPARE_XPRA</td>
<td>This phase prepares the execution of the XPRAs and after-import methods.</td>
</tr>
<tr>
<td>UNLOCK_EU (only in the Downtime-minimized import mode)</td>
<td>This phase unlocks the development environment.</td>
</tr>
<tr>
<td>AUTO_MOD_SPAU</td>
<td>It checks whether modifications can be adjusted automatically.</td>
</tr>
<tr>
<td>Xhra_EXECUTION</td>
<td>This phase executes the XPRAs and after-import methods.</td>
</tr>
<tr>
<td>Phase</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CRM_UNLOCK_RTIME_GEN</td>
<td>This phase is run only if you use a CRM system. In this phase, the generation of runtime objects is unblocked and CRM Adapter Repository tables are adjusted.</td>
</tr>
<tr>
<td>CRM_MERGE_BDOCS</td>
<td>This phase is run only if you use a CRM system. In this phase, inconsistent BDoc messages are adjusted.</td>
</tr>
<tr>
<td>CRM_REGEN_RTIME_OBJS</td>
<td>This phase is run only if you use a CRM system. In this phase, changed runtime objects are regenerated.</td>
</tr>
<tr>
<td>CRM_START_QUEUE</td>
<td>This phase is run only if you use a CRM system. In this phase, the replication and realignment queues are restarted and the inbound queue is logged on.</td>
</tr>
<tr>
<td>ABAP_GENERATION</td>
<td>This phase generates the runtime objects for the imported Repository objects (ABAP source code and screens).</td>
</tr>
<tr>
<td>Clean Up Module</td>
<td></td>
</tr>
<tr>
<td>RUN_SPAU_?</td>
<td>This phase prompts you to adjust your modifications to repository objects by calling transaction SPAU.</td>
</tr>
<tr>
<td>CLEAR_OLD_REPORTS (only in the Downtime-minimized import mode)</td>
<td>This phase deletes obsolete versions of program code and program texts in the database.</td>
</tr>
<tr>
<td>EPILOGUE</td>
<td>This phase completes the import process. Among other things, it checks whether the queue has been processed completely.</td>
</tr>
</tbody>
</table>
6 Troubleshooting

Support Package Manager runs through various phases during an import. If errors occur, Support Package Manager terminates the import process in order to keep the system consistent. After correcting the error, you can continue importing the Support Package.

If the import is terminated, a dialog box appears informing you which phase was interrupted, and why. You can also display this dialog box by choosing Goto Status Queue, Support Package or SPAM Update (see also Displaying Additional Status Information [page 40]). This dialog box provides you with troubleshooting tips on removing the error for the phase in question. You may also have to reset the status of the Support Package.

You can find a list of the most important Notes from the Online Correction Service (OCS) in SAP Note 97620, which is regularly updated.

If you cannot solve your problem using these Notes or with the following information, send an error message in SAP Support Portal using the information from the error dialog box. Assign your message to component BC-UPG-OCS. Also read SAP Note 97660 before creating your error message.

Related Information

Performing ABAP/Dynpro Generation [page 47]
Checking the Status of Background Processing [page 49]
Test Import [page 50]
Checks While Importing a Queue [page 51]
Errors in Support Package Manager Phases [page 54]
Resetting the Status of a Support Package [page 62]
Deleting the Queue [page 63]

6.1 Performing ABAP/Dynpro Generation

Support Package Manager is set up by default so that there is no ABAP or dynpros are generated during the import. The relevant programs are generated only when they are called. However, you can define Add-On Installation Tool so that these objects are generated during the installation process. Alternatively, you can start generation of all imported objects after the import process, using the SAP Load Generator.
Context

Support Package Manager may return error messages during generation. This could be because a program written by the customer or a modification of an existing program contains syntax errors, and refers to an object that is imported as part of the queue. It is usually best to ignore the generation error at first and correct it after the Support Package has been imported.

To make settings for the generation of ABAP programs and dynpros, on the initial screen in Support Package Manager, choose Extras <menu option>.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch generation on and off</td>
<td>Settings</td>
</tr>
<tr>
<td>Ignore generation errors during import</td>
<td>Ignore Generation Errors</td>
</tr>
</tbody>
</table>

If you have deactivated generation in the Support Package Manager settings, you can use the SAP Load Generator to perform generation after the Support Package queue has been imported (transaction code SGEN).

→ Recommendation

We recommend using this method for ABAP/dynpro generation of large numbers of objects after you have imported Support Package queues. The SAP Load Generator saves you time, since the generation set is processed in parallel on multiple application servers.

When you import Support Packages, this invalidates the loads of the ABAP objects that are contained in the Support Packages. The DDIC import invalidates the loads of the ABAP objects that reference imported DDIC objects. This means that the loads have to be generated again. You can use the SAP Load Generator to generate the ABAP objects for exactly this object set.

i Note

If you want to generate invalidated loads at regular intervals, you can periodically schedule program RSGENINVLAS. You can find more information in the online documentation for the SAP Load Generator, under Automatic Regeneration of Invalidated Loads.

Procedure

1. Call SAP Load Generator (transaction SGEN).
2. Choose Regenerate Existing Loads and then choose Continue.
3. Choose Generate Objects with Invalidated Loads Only.

   By doing this, you can ensure that objects whose load was invalidated when a Support Package queue was imported are regenerated.
6.2 Checking the Status of Background Processing

If you have scheduled the import of OCS Packages in the background, you can check the status of the scheduled background job in Job Administration.

Prerequisites

In the start options [page 30], you have specified that you want at least one module to be processed in the background.

To make changes to a background job that has been scheduled by another user, you need the relevant authorization.

Context

Checks on background processing may be necessary, for example, if the system is shut down while a background job is running, causing the background processing to change to an inconsistent state.

Support Package Manager and the SAP Add-On Installation Tool do not allow you to change the parameters of a background job after it has been scheduled. If you want to modify a background job later (to change the start time of the import, for example) or if you want to delete the job entirely, you can do this in Job Administration.

The job scheduled for background processing is called OCS_QUEUE_IMPORT.

Procedure

1. Call Job Administration by choosing the Environment menu in the import tool, or by calling transaction SM37.

   Alternatively you get to the menu using System Own Jobs in the display of your own jobs. Here you can see an overview of jobs you have scheduled in the past, together with their status. Choose Job Selection to go to Job Administration.

2. Select the job OCS_QUEUE_IMPORT.

3. Choose one of the following:
   - Check the status of the job
   - Check the job log
   - Make changes to the job
   - Delete the job
Results

The import tool copies the changes from Job Administration. If you have deleted a background job, the status of the package queue changes accordingly. In the import tool, you can restart or reschedule the import of the OCS queue either in the dialog or in the background.

You can find more information on background processing in Job Administration, under Help Application Help.

6.3 Test Import

In the TEST_IMPORT step, Support Package Manager checks whether the objects in the Support Package queue can be imported without any errors.

Prerequisites

You are testing the import of the Support Package queue.

Context

Errors occur if objects are in tasks that have not been released yet, and would be overwritten during the import process if transport objects do not match the system (due to incorrect include numbers for function modules or non-permitted tables contents, for example) or if transport control program tp does not run without errors.

Procedure

1. Use the information from the test import log to analyze the cause of the error.
2. Choose one of the following:
   - Correct the error.
     Once you have done this, you can continue the import process by choosing Support Package Import Queue on the initial screen in Support Package Manager.
   - Skip the error.
     To do this, go to the initial screen in Support Package Manager and choose Extras Ignore Test Import Errors.

⚠️ Caution

You must be careful here. If you ignore errors during the test run (regardless of what caused them), they may occur again when you import the objects in the IMPORT_PROPER step. This can cause
Next Steps

Errors During Support Package Manager Phases [page 54]

6.4 Checks While Importing a Queue

To ensure imports of OCS packages (support packages, add-on installation packages, or add-on upgrades) run as smoothly as possible, the import tool executes various checks in the Preparation module.

Check the Transport Tools tp and R3trans

The transport tools tp and R3trans must work correctly when importing a queue. If errors occur here, the system shows the following error message: TP_CANNOT_CONNECT_TO_SYSTEM. The cause is usually an error in the configuration of transports in Transport Management System (transaction STMS). You can call a detail check for more precise information on the errors and the possible causes. To do so, choose Utilities > Check Transport Tool. Solve the error and continue the import.

Check Minimum Versions of the Transport Tools tp and R3trans.

Some functions of the import tools and the OCS packages themselves require minimum versions of the transport tools tp and R3trans. If the required minimum versions of the transport tools are not installed, the system displays this in a dialog window. Load at least the minimum required versions (or newer) of the tools from SAP Support Portal and install them (see SAP Note 19466). Then continue the installation process.

Check User DDIC Status

The system executes individual import steps under the control of the user DDIC. For this the user DDIC must exist and not be locked. If this is not the case, the system shows a message that informs you how you can solve the problem. Follow the instructions. Then continue the installation process.

Since user DDIC can pose a security threat, it is possible to set a different user to process the import steps via the configuration page in the transport system. For more information, see the section dealing with the transport system in the SAP NetWeaver Security Guide, under https://help.sap.com/nw > SAP NetWeaver Platform > <your release version> > Security > SAP NetWeaver Security Guide. In this case, deactivate the check for user DDIC.
Check Open Data Extraction and V3 Update Requests

If changes are made to DDIC structures by an import, it is possible that open data extractions and V3 update requests can no longer be processed. The processing must take place before the Import 2 module is started. For more information about these data extraction requests, see 1081287, 1083709, and 328181.

If the system finds open requests, it shows them in a dialog box and cancels the import process. You either have to process the open requests (or not) before continuing with the import depending on whether you have defined the import tool to execute the processing of the Import 2 module immediately or start manually in the start options. If you have chosen manual start the Import 2 module you can first ignore this warning message with the Skip pushbutton.

Check for CRM-Specific System Settings

This check is performed only if you use a CRM system.

For CRM packages to be able to be imported, certain system settings are required. If these settings have not been made, you are prompted to adjust the settings. Then continue the installation process.

Check the Transport Requests Still to be Imported in the Transport Management System (TMS)

To avoid problems, only import transport requests into systems that have the same system status as the installed software component versions (including the support package level) as the export system at the time of the export. This checks if there are transport requests in the import queue of the TMS that are to be imported before importing the package queue. If this is the case, the system displays the transport requests in a dialog box. You can jump directly to the TMS using the TMS - Import Queue pushbutton and start the import of the transport requests.

If you are sure that the transport requests that are still to be imported are independent from the system status and the OCS packages that are to be imported, you can ignore the check with the Skip pushbutton and continue with the import.

Check the Signature of OCS Packages to be Imported

OCS packages from SAP have a digital signature. This can be checked using the signature manifest when the queue is imported. If errors occur during the check, you need to resolve these problems before you can continue with the import process. You can find details about these errors in the action log for the phase DISASSEMBLE.

If the digital signature check fails, you should delete the relevant EPS file from the EPS inbox. Then you should download the installation package or support package from the SAP Support Portal again, and load the SAR archive into the system using one of the options under Support Packages or Installation Package Load Packages.

If a warning appears prompting you to check the installation packages or support packages, then you should check them. If the check cannot be run due to a missing manifest file, reload the SAR archive for the relevant installation or support package into the system, using one of the options under Support Packages or Installation Package Load Packages.

If you think the warning is not critical, you can skip the warning by pressing Ignore.

Check for Note Correction to be Implemented Before Import

It is possible that OCS packages can only be imported after specific note corrections have been implemented in the system. For example, this makes sense to avoid import errors as a result of known and corrected
software errors. If this is the case, the system lists the SAP Notes to be implemented in a dialog box. You can use the **Note Assistant** pushbutton to jump straight to the Note Assistant and implement the specified SAP Notes.

**Check for Open Conversion Requests in the DDIC**

When importing transport requests, table conversions and requests for creating table indexes can be triggered which can be canceled for different reasons. Since such requests are also processed when importing OCS packages and can then cause serious problems, they have to be processed or removed before the import.

If requests like this exist, the system displays the affected objects in a dialog box. To check the specified objects, use the DDIC tools of transactions **SE11** or **SE14**. Either process the open conversion requests completely or, if this is no longer necessary, delete them.

**Check for Open Workbench Requests**

If objects that are also changed by the imported OCS packages were changed locally in the system, this change must be completed, which means that the related workbench change request must be released. Only in this way can you ensure that local changes and OCS package changes do not conflict and that a modification adjustment is possible.

If objects from the imported OCS packages are still locked in open workbench requests, the system displays them in a dialog box. By double-clicking a request you can branch directly to the request display and release the request directly, as long as you have the required authorization and are logged on in the relevant client. You can continue with the import when all open workbench requests are released.

**Check for Inactive Objects**

If objects from the imported OCS packages are still inactive, the system displays them in a dialog box. By double-clicking on the object name, you can open the object display directly and activate the object (provided that you have the required authorization and are logged on in the relevant client). Once you have activated all of the inactive objects, you can continue with the import.

**Check on Add-On Conflicts**

If an imported support package has a higher version than specified by the import prerequisites for the add-on, conflicts can arise. Conflicts can also arise between installed add-ons and support packages included as import prerequisites or between the objects of a new add-on and the objects of installed add-ons.

If conflicts occur, cancel the process by choosing **Back**. Review the following options:

- **Conflict between installed add-on and new add-on**
  - Ask the vendor whether a version of the new add-on is available that is compatible with the installed add-on. If this is the case, start the process again with the compatible version.
  - Check whether the installed add-on can be uninstalled. If this is the case, uninstalled it can start the process again.

- **Conflict between installed support package and new add-on**
  Check whether an appropriate CRT is available. If this is the case, load it into your system and start the process again. The CRT is included automatically.

If the conflict cannot be resolved, the add-on cannot be installed.
6.5 Errors in Support Package Manager Phases

If an error is recognized during a phase, Support Package Manager stops the import process until the error is corrected. You can get information about the reason the SPAM transaction was stopped and in which phase by choosing [Queue] [Status].

Error Types

- Support Package Manager Security Checks
  A typical example is the OBJECTS_LOCKED_? phase. Support Package Manager stops the import process if objects that need to be overwritten by the queue are still locked in requests.

- Error messages of programs tp and R3trans.
  You can always find the cause of the error in the relevant transport log. A typical example is the TEST_IMPORT phase. This step checks whether there are unconfirmed repairs to objects that need to be overwritten by the queue. The objects in question are listed in the test import log.

- Incorrect configuration of the Change and Transport System
  Frequent errors here include missing rights on the files in Change and Transport System or using old program versions of tp or R3trans. Check the configuration of the transport tools by choosing [Utilities] [Check Transport Tool].
  A typical example is the DISASSEMBLE phase. If <sid>adm does not have write rights for the directory /usr/sap/trans/data (UNIX), Support Package Manager stops in the phase DISASSEMBLE with the message CANNOT_DISASSEMBLE_R_DATA_FILE.
  The Support Package Manager requires the Change and Transport System to be configured correctly (see https://help.sap.com/nw <your release> [Application Help] [Function-Oriented View: English] [Solution Life Cycle Management] [Software Logistics] [Change and Transport System]).

Known Errors

PROLOGUE

In this phase, a dialog box prompts you to confirm the import of the Support Package. If you are not authorized to use Support Package Manager, or if the current queue has not yet been confirmed, Support Package Manager stops with a message to this effect.

CHECK_REQUIREMENTS

This phase checks various requirements for importing a Support Package. It may terminate for the following reasons:

- TP_CANNOT_CONNECT_TO_SYSTEM: tp cannot log onto the system's database.
- **QUEUE_NOT_EMPTY**: The tp buffer contains incompletely processed OCS requests. You can display these requests with the following tp command:

```bash
tp SHOWBUFFER <SID> -D SOURCESYSTEMS= TAG=SPAM
```

You can continue editing the queue when these requests have been completed or deleted from the tp buffer.

- **OPEN_MOVE_NAMETABS**: There are inactive runtime objects for ABAP Dictionary objects. To activate them, call transaction SE11.

- **CRM_REQ_FAILED**: CRM-specific settings have not been made. To adjust the settings, start transaction SA38 and run program GN_XPRA_CRM40.

**DISASSEMBLE**

In this phase, files from the corresponding EPS parcels are unpacked and stored in the directory `/usr/sap/trans/data` (UNIX). It creates the command files (cofiles) from the accompanying files and saves them to the directory `/usr/sap/trans/cofiles` (UNIX). The import log tells you what caused the errors and what can lead to the termination of this phase. The most common causes are:

- The EPS parcel is not in the EPS Inbox, because it may have been deleted. You need to download the relevant Support Package again.
- The signature manifest of an EPS package is either incorrect, contains errors or does not exist. To continue, delete the relevant package and reload it from the SAP Support Portal or your collection CD (as described in Loading Support Packages from the Application Server [page 17]).
- The name of a data file could not be determined, because a profile parameter was not correctly configured. Use the report RSPARAM to check the settings.
- An R3trans data file could not be disassembled. Possible errors include a missing EPS parcel or a data file that could not be written to. An error occurred while transmitting a 20K block from the EPS Inbox to directory `/usr/sap/trans/data` (UNIX).
- The cofile could not be created from the relevant data file. One of the possible causes for the error is that <sid>adm does not have write authorizations for the `/usr/sap/trans/cofiles` (UNIX) directory. Check whether the data file has been created. If it has not been created, check that the option Create New Data File is activated in the Settings [page 8].
- An R3trans data file exists in the transport directory, which is newer than the one that is to be unpacked from the EPS package. Do not import the obsolete version. Proceed as follows instead:
  1. Delete the current queue.
  2. Download the newest version of the relevant OCS package.
  3. Restart the import.

**ADD_TO_BUFFER**

This phase adds the queue to your system’s transport buffer. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called. An RFC error occurred.
- **CANNOT_ADD_PATCH_TO_BUFFER**: A Support Package could not be included in the transport buffer. For more information, see the SLOG log file in directory `/usr/sap/trans/log` (UNIX).
MODIFY_BUFFER

This phase prepares the transport buffer so that the subsequent import phases can be processed correctly. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called. An RFC error occurred.
- **CANNOT_MODIFY_BUFFER**: An unsuccessful attempt was made to modify the transport buffer.

IMPORT_OBJECT_LIST

This phase imports the object lists for the Support Packages in the queue into the system. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The tp program could not be executed. For more information, see the SLOG or ALOG log file.
- **COMMAND_FILE_IMPORT_FAILURE**: The object list for one or more Support Packages could not be imported. You can find the source of error in the command file import log.

TEST_IMPORT

This phase checks whether any objects overwritten by the import are still in unreleased tasks. You can find the source of error in the log of the test import.

You can skip test import errors and continue the import process by choosing Extras Ignore Test Import Errors. However, depending on the type of error, this may cause the error to reappear with very serious consequences during the real import. You therefore always need to check test import errors first, and correct them wherever possible.

OBJECTS_LOCKED_?

This phase checks whether any objects overwritten by the import are still in unreleased requests. It may terminate for the following reasons:

- **CANNOT_GET_OBJECT_LIST**: The object list for a Support Package could not be found, because the Support Package does not exist.
- **CANNOT_CHECK_LOCKS**: An error occurred when checking the locks of an object in the queue.
- **OBJECTS_LOCKED_IN_REQUESTS**: Objects were found that are still in requests that have not yet been released. Release these requests before continuing importing the Support Packages.

CHECK_INACT_OBJECTS

This phase checks whether there are still objects that are inactive. It may terminate for the following reasons:

- **CANNOT_GET_OBJECT_LIST**: The object list for a Support Package could not be found, because the Support Package does not exist.
- **CANNOT_CHECK_INACT_OBJ**: An error occurred when checking the status of an object in the queue.
- **SHOW_DETAIL_AND_DECIDE**: Objects have been found that are still inactive. Activate the objects before continuing with the import.
**ADDON_CONFLICTS_?**

This phase checks for conflicts between objects in the queue and installed add-ons. If it finds any, Support Package Manager stops and prompts you to import the relevant Conflict Resolution Transports (CRTs). It may terminate for the following reasons:

- **CANNOT_GET_OBJECT_LIST**: The object list for a Support Package could not be determined, because the Support Package does not exist.
- **CANNOT_GET_LAST_UPGRADE_INFO**: The information about the component upgrade could not be determined.
- **UNRESOLVED_ADDON_CONFLICTS**: Conflicts with add-ons could not be resolved, because the relevant CRTs are missing from the queue.

**SCHEDULE_RDDIMPDP**

This phase schedules the transport daemon (program RDDIMPDP). It may terminate for the following reasons:

- **CANNOT_SCHEDULE_RDDIMPDP**: The job RDDIMPDP could not be scheduled. Call the transaction SM37 (job selection), enter the following parameters and choose **Continue**:

<table>
<thead>
<tr>
<th>Job Name</th>
<th>RDDIMPDP</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>&lt;&lt;user name&gt;&gt;</td>
</tr>
<tr>
<td>Trigger event</td>
<td>SAP_TRIGGER_RDDIMPDP</td>
</tr>
</tbody>
</table>

Select the job that was terminated and display the job log.

- Problems with the SAP locking mechanism: Call the transaction SM12 and make sure that no programs have the name RDDIMPDP.

**CREATE_VERS_BEFORE**

This phase creates versions in the version database of the objects that you want to import and for which versions can be created (ABAP code, dynpros, and DDIC objects). It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.
- If the return code is 0152 (nothing done), check whether the VERS_AT_IMP parameter is set as **ALWAYS** in the configuration of the transport tools in the Transport Management System (transaction STMS). If it is not, set this value and continue importing the queue.
- **TP_STEP_FAILURE**: The tp step CREATE_VERS_BEFORE could not be performed successfully. To find the exact cause of the error, choose | Goto | Log | Queue | and look at the version log.

**SPDD_SPAU_CHECK**

In this phase, the system checks whether a modification adjustment is necessary (transactions SPDD/SPAU).

**DDIC_IMPORT**

This phase imports ABAP Dictionary. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
• **TP_FAILURE**: The tp program could not be executed. For more information, read the SLOG or ALOG log files.
• **CANNOT_IMPORT_DDIC**: ABAP Dictionary could not be imported. You can find the source of the error in the dictionary import log.

**AUTO_MOD_SPDD**

This phase checks whether all modifications to ABAP Dictionary objects can be adjusted automatically.

**RUN_SPDD?**

In this phase, you are prompted to adjust your modifications to ABAP Dictionary objects by calling transaction SPDD.

**LOCK_EU (only for import mode Downtime-minimized)**

This phase locks the development environment. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.

**INACTIVE_IMPORT (only for import mode Downtime-minimized)**

This phase imports program code and program texts in an inactive state. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.
- **TP_STEP_FAILURE**: The tp step INACTIVE_IMPORT could not be executed successfully. The cause of the error is in the relevant log (SAPBxxxxxx<SID>). This log is in subdirectory log in the transport directory. To display this file, run the report RSPUTPRT, or call transaction AL11.

**CRM_STOP_QUEUE_BDOCS**

In this phase, replication and realignment queues are stopped, inbound queues are logged off, and BDoc messages are processed completely. The following errors can cause the phase to terminate:

- **CRM_STOP_QUEUE_FAILED**: The queues could not be stopped.
- **CRM_ACTION_FAILED**: The action could not be executed.
- **CRM_STATE_EVALUATION_FAILED**: The result of this action could not be read.

**CRM_LOCK_RTIME_GEN**

In this phase, the generation of CRM runtime objects is blocked. The following errors can cause the phase to terminate:

- **CRM_LOCK_GEN_FAILED**: The generation of CRM runtime objects could not be blocked.
- **CRM_ACTION_FAILED**: The action could not be executed.
- **CRM_STATE_EVALUATION_FAILED**: The result of this action could not be read.
**DDIC_ACTIVATION**

This phase activates the imported ABAP Dictionary objects. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.
- **TP_STEP_FAILURE**: The tp step DDIC_ACTIVATION could not be executed successfully. To view the cause of the error in the activation log, choose Goto Log Queue. If you import two or more Support Packages in a queue, activation errors can result from an incorrect activation sequence for dictionary objects. If this is the case, the activation errors disappear if the objects are activated again. To do this, choose Support Package Import Queue.

**IMPORT_PROPER**

This phase imports all repository objects and table entries. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The tp program could not be executed. For more information, read the SLOG or ALOG log files.
- **TP_STEP_FAILURE**: A tp step could not be performed successfully. You can find the source of error in the relevant log, for example, in the import log.

If a tp step 6, N, or S is in the termination message, it is a step independent of the transport request. The relevant logs can be found in the log overview under Import steps not specific to the transport request. Alternatively, you can find these logs in the following files in the log directory of your transport directory (usually: /usr/sap/trans/log):
  - tp step 6: P<YY><MM><DD>.<SID>
  - tp step N: N<YY><MM><DD>.<SID>
  - tp step S: DS<YY><MM><DD>.<SID>

To display these files, run the report RSPUTPRT or call transaction AL11.

**PREPARE_XPRA**

This phase prepares the execution of the XPRAs and after-import methods. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **CANNOT_MODIFY_BUFFER**: The tp program could not change the corresponding buffer file. For more information, read the SLOG log file.

**UNLOCK_EU (only for import mode downtime-minimized)**

This phase unlocks the development environment. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.

**AUTO_MOD_SPAU**

This phase checks whether modifications can be adjusted automatically.
XPRA_EXECUTION

This phase executes the XPRAs and after-import methods. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The tp program could not be executed. For more information, read the SLOG or ALOG log files.
- **TP_STEP_FAILURE**: The tp step XPRA_EXECUTION could not be performed successfully. To find the cause of the error, read the method execution log. To view the cause of the error in the log, choose Goto Log Queue.
- **CANNOT_READ_BUFFER**: The tp program could not open the corresponding buffer file. For more information, read the SLOG log file.
- **CANNOT_MODIFY_BUFFER**: The tp program could not change the corresponding buffer file. For more information, read the SLOG log file.

CRM_UNLOCK_RTIME_GEN

In this phase, the generation of runtime objects is unblocked and CRM Adapter repository tables are adjusted. The following errors can cause the phase to terminate:

- **CRM_UNLOCK_GEN_FAILED**: The generation of CRM runtime objects could not be unblocked.
- **CRM_ACTION_FAILED**: The action could not be executed.
- **CRM_STATE_EVALUATION_FAILED**: The result of this action could not be read.

CRM_MERGE_BDOCS

In this phase, BDoc messages are adjusted. If there are inconsistent BDoc messages, the phase terminates and you need to adjust the corresponding BDoc message manually. The following errors can cause the phase to terminate:

- **CRM_MERGE_BDOC**: After the changes have been imported, BDoc messages may be inconsistent and need to be synchronized. The synchronization takes place in the BDoc Modeler. Use the Transfer pushbutton to call the BDoc Modeler. BDoc types with inconsistent versions are indicated accordingly.
- **CRM_ACTION_FAILED**: The action could not be executed.

CRM_REGEN_RTIME_OBJS

In this phase, changed runtime objects are regenerated. The following error can cause the phase to terminate:

- **CRM_RUNTIME_GENERATION**: If you have not yet planned a job for regenerating runtime objects, the import process is stopped and you have the option of starting the regeneration of runtime objects manually or creating a job.

CRM_START_QUEUE

In this phase, the replication and realignment queues are restarted and the inbound queue is logged on. The following errors can cause the phase to terminate:

- **CRM_START_QUEUE_FAILED**: The replication and realignment queue could not be started.
- **CRM_START_INB_Q_FAILED**: The inbound queue could not be logged on.
- **CRM_ACTION_FAILED**: The action could not be executed.
- **CRM_STATE_EVALUATION_FAILED**: The result of this action could not be read.
**ABAP_GENERATION**

This phase generates the runtime objects for the imported repository objects (ABAP source code and dynpros). It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.
- **TP_STEP_FAILURE**: The tp step could not be executed successfully. To view the cause of the error in the generation log, choose [Goto Log Queue](#).

Remember that objects delivered in Support Packages have already been imported completely. If the return code is 0008, all objects without syntax errors have been generated.

The persistence of syntax errors can be due to one of the following reasons:

- Systems that have been developed over a long period of time often contain many objects that are not longer used or maintained. These objects are still active in the repository and can reference or use other objects (such as includes). If these includes are modified, syntax errors might occur in the obsolete objects. However, these errors have no effect on the SAP System, and can be ignored.
- Generated includes or programs can contain syntax errors after an import. You can usually ignore these errors, since the source code of the generated objects is generated again when the corresponding transactions are started (a special generation transaction might exist).
- If SAP objects have been modified, or if customer objects use SAP objects, there are may also be syntax errors in the modified SAP objects and the customer objects. If this is the case, you must adjust the modifications or customer developments.
- Buffer synchronization problems can also cause generation errors. Generation errors do not necessarily indicate inconsistencies in the system. However, you should investigate them using the criteria above. If the errors are non-critical, or temporary, ignore them by choosing [Extras Ignore generation errors](#) and continue importing the queue. Choose [Support Package Import Queue](#).
- **CANNOT_READ_BUFFER**: The tp program could not open the corresponding buffer file. For more information, read the SLOG log file.
- **CANNOT_MODIFY_BUFFER**: The tp program could not change the corresponding buffer file. For more information, read the SLOG log file.

**RUN_SPAU_?**

It prompts you to adjust your modifications to repository objects by calling transaction SPAU.

**CLEAR_OLD_REPORTS (only for import mode Downtime-minimized)**

This phase deletes obsolete versions of program code and program texts from the system. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The program tp could not be executed. For more information, read the SLOG or ALOG log files.
- **TP_STEP_FAILURE**: The tp step CLEARREPORTS could not be performed successfully. The cause of the error is in the relevant log (PZ<yy><mm><dd>.<SID>). This log is in the log subdirectory in the transport directory. To display this file, run the report RSPUTPRT, or call transaction AL11.
EPILOGUE

This phase completes the import process. The system checks if the queue has been completely processed. If it has, there should be no more transport buffer entries for the queue. It may terminate for the following reasons:

- **TP_INTERFACE_FAILURE**: The tp interface could not be called.
- **TP_FAILURE**: The tp program could not be executed. For more information, read the SLOG or ALOG log files.
- **QUEUE_STILL_IN_BUFFER**: The queue was not processed completely, since there are still incomplete Support Packages from the queue in the transport buffer.

For more information on known problems, see the Notes referred to for your release in SAP Note 97620.

6.6 Resetting the Status of a Support Package

If you have to import a Support Package queue again from the beginning because of errors, remember to reset its status.

Prerequisites

⚠️ **Caution**

You can only delete the queue if module Import 1 has not yet started (up to phase SCHEDULE_RDDIMPDP).

If you have scheduled a module to run in the background, you need to delete this scheduled job before you can reset the status (see Checking the Status of Background Processing [page 49]).

Procedure

- To reset the status of a Support Package queue, choose **Extras > Reset Status**.
  
The status is reset to the state of the phase PROLOGUE.

Next Steps

You then have to import the Support Package again completely. Support Package Manager starts the import process with phase PROLOGUE [page 44].
6.7 Deleting the Queue

If you have already defined a queue, but are not satisfied with it, or if errors have occurred, you can delete it.

Prerequisites

If you have scheduled a module to run in the background, you must delete this scheduled job before deleting the queue (see Checking the Status of Background Processing [page 49]).

*Note

You can only delete the queue if module Import 1 has not yet started (up to phase SCHEDULE_RDDMPDP).

Procedure

1. In the initial screen in Support Package Manager, choose Display/Define. A dialog box displaying the current queue appears.
2. Choose the Delete Queue icon.

Results

The queue has been deleted. You can now define a new queue.
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon 🌐: You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.

- Links with the icon 🌐: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.